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1 Introduction

1.1 General workshop information

The Joint Cooperation Program (JCP) is a collaborative 5-year partnership established
between Dutch and Indonesian institutes working in the field of climate and water
resources management. Phase | of the JCP started in February 2011 and it is due to
finish in December 2012. The objective of the cooperation as stated in the Joint
Cooperation Agreement is to carry out a long-term knowledge sharing and capacity
building program between the four participating institutes, namely KNMI, BMKG, PusAir
and Deltares. The ultimate aim is to increase the state of the art of the knowledge base
of the institutes involved and to strengthen the institutional capacity of Indonesian
organization involved in planning, development and management of water resources
systems.

The Dutch research institute Alterra joined the JCP in 2012. Alterra’s involvement is
linked to Component B of the Joint Cooperation. Within this component, the institute will
contribute on a study on food security in the Einlanden-Digul-BikumaRiver basin by
analyzing current and foreseen land and water use choices.

1.1.1  Aim of the workshop

During this workshop, participants will jointly work on the development of competences
to perform hydrometeorological analysis using publicly available datasets and tools.
The workshop is expressly carried out to contribute to the work plan of Component B
and C2 of the JCP, namely the Collaborative Development of Integrated Water
Resources Management tools (Component B) and the Water Management Datasets for
River Basin and Lowlands (Component C2).

The focus of Component B of the JCP is to develop a reference case study for
hydrological analysis in geographic areas with limited data availability. The aim is to
define procedural guidelines for the implementation of IWRM studies in Indonesia. The
selected case study for Component B is the Einlanden-DigulBikumaRiver Basin in the
South-East of PapuaProvince.

Component C2 of the JCP has the objective to develop capacity and tools for effectively
collecting and using global datasets which will help PusAir and BMKG in their task to
support river basin and water management organizations throughout Indonesia through
(i) provision of data, (ii) capacity building, and (iii) strategic analyses for policy support.
The JCP aims to achieve this goal through the collection of data for those river basins in
Indonesia that are currently of special interest to PusAir.

This manual aims to provide the theoretical background and practical exercises to get
participants acquainted with freely available global datasets and tools for
hydrometeorologicalmodeling, where to find them and how to use these instruments to
improve practices of water resources planning and management in Indonesia.
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1.1.2 Trainers, time plan and workshop content

This workshop will be guided by NeeltjieGoorden and AgneseBoccalon, and will be
supported by the coordination of Ronald Vernimmen. Bouke Pieter Ottow, a student of
Civil Engineering from the University of Twente (Netherlands) will also assist the
workshop participants in the execution of their daily tasks. Bouke Pieter will be in
Indonesia during the period February 2012 — May 2012 to carry out his BSc thesis
research, hosted by the Research Centre for Water Resources (PusAir) in Bandung.
NeeltieGoorden is a Geo-hydrologist at the Groundwater Management Department
(GWB) of the Subsurface and Groundwater Systems Unit (BGS) of Deltares.
AgneseBoccalon is a Water Resources Planner at the Sustainable Use of Water ad
Soils Department (DWB) of the Scenarios and Policy Analysis Unit (VEB) of Deltares.
Ronald Vernimmen is a Researcher at the Catchment Hydrology Department (HYD) of
the Inland Water Systems Unit (ZWS) of Deltares.

During the workshop Dr.ArdhasenaSopaheluwakan from BMKG will also contribute to
the workshop content by giving a presentation with the title “A low dimensional model
for ENSO index forecast system using global dataset’. With the aim to relate the
content of his work to the use of global datasets used for the estimation of precipitation
and potential evapotranspiration from remote sensing data, Dr.Sopaheluwakan will
deliver his presentation on Wednesday 15".

The workshop takes place in Citeko, at the BMKG training center, and runs from

Monday 13" to Friday 17", February 2012. Lectures and training will be provided
according to the following time plan:

Table 1.1 Time plan and programme of the workshop (M = morning, A = afternoon).

Day Content

- Introduction, interest assessment of participants, groups
formation and familiarization among attendees

- Data and software distribution + installation

— Introduction to the analysis tools used in this workshop
Monday 13" — Introduction to Quantum GIS;

- Introduction to data preparation (selection in a raster and
A | vector environment, use of different coordinate systems, layers
formatting);

— Group daily report drafting and presentations

- Recap on previous day

M| - Preparation of topographic data
Tuesday 14" — Preparation and reclassification of land cover data
Al Exercises

— Group daily report drafting and presentations

- Recap of previous day

M|~ Preparation and reclassification of soil types data

- Preparation of precipitation and potential evapotranspiration
data

- Presentation on “A low dimensional model for ENSO index
A forecast system using global dataset” (Dr.Sopaheluwakan )

- Exercises

— Group daily report drafting and presentations

Thursday 16" | M| —  Recap of previous day

Wednesday 15"

Deltares 2
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- Introduction and use of PCRaster and WFlow
Al Exercises
— Group daily report drafting and presentations

- Summary on the content of the workshop

- Final presentation by trainees and participants
- Follow up

— Handing out of certificates

Friday 17" M

The workshop is organized in 5 daily sessions. For each session, participants will form
working groups of 3-4 people to exercise on each module. Each group will be assigned
an Indonesian river basin to carry out the analysis (Table 1.2). At the end of each day,
the different groups will have to draft a short daily report summarizing on the activities
carried out during the day. This report will later be used to draft a final comprehensive
report on the set of activities performed during the workshop, the methodology and the
approaches used for data analysis, retrieval and preparation.

At the end of each daily session — and after carrying out the exercises — the groups will
give short presentations about their daily work to share their experience with the rest of
the participants. This will be a moment for discussion and confrontation about
methodology and approaches used during the analysis, problems encountered and type
of solutions found. To stimulate collaborative participation among the attendees, we
would like to make this workshop as interactive as possible. This way, participants will
have the opportunity to apply the theoretical knowledge to real cases by working along
with colleagues from partner institutions, and with the trainers from Deltares. This
process aims to facilitate national and international institutional interactions, contributing
to both the aim of Components B and C2 of the Joint Cooperation Program.

Table 1.2 Selection of Indonesian river basins used in the exercises of the workshop.
Group River basin Name ID Island Geographical
reference
A Citarum CTR Java UTM 48S
B Bengawan Solo BNG Java UTM 49S
C Jratunseluna JRN Java UTM 49S
Kali Garang (sub- KGA Java UTM 49S
D
catchment of C)
E Einlanden EIN Papua UTM 54S
F Digul DIG Papua UTM 54S
G Bikuma BIK Papua UTM 548

A map of the Universal Transverse Mercator (UTM) system is provided in Figure 2.3.

1.1.3 Content of your USB stick

All the software and information required for this training are provided with the USB
drive that has been given to you at the beginning of this workshop.

The content of the USB is organized using a thematic structure. On the USB you will
find the following directories:
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1.2 Hydrometeorological analysis using freely available software and global
datasets

1.2.1 Required input parameters for hydrometeorological analysis

Hydrometeorological analysis in the context of water resources management is an
important tool for decision-makers to assess water resources availability in a temporal
and spatial scale. With this information, plans for natural resources developments or
conservation can be identified and evaluated against physical and structural
constraints.

A thorough hydrological analysis takes into account quantitative and qualitative aspects
of water availability. However, although most studies start from an analysis of the
quantitative component, water availability alone is not enough. With increasing pollution
from domestic consumption, agricultural and industrial production, water resources
need equally to be assessed in terms of their water quality to effectively plan current
and future potential water uses. Water quantity and water quality are therefore the two
major areas on which water resources managers need to focus their efforts on.

For the specific scope of components B and C2 of the JCP, during this workshop we
will only deal with the quantitative aspects of the hydrological analysis. At a later stage,
the results of this analysis can then be used to evaluate available water resources also
based on their qualitative aspects.

With the river basin as the unit of analysis for hydrological modeling, there are a
number of hydrometeorological input parameters needed to prepare a thorough water
resources assessment. As a general practice, a hydrological analysis includes a water
supply and a water demand component. Water supply is understood in terms of water
availability through natural (i.e. precipitation, river discharge, groundwater) and artificial
(i.e. dams, rain water harvesting) sources, while water demand represents the
requirements for water driven by anthropogenic (e.g. domestic, agricultural and
industrial water use) and ecosystem services (e.g. ecological water requirements).
Once the patterns of water availability are known, they can be combined with the water
demand functions from the different water users to formulate a basin-wide water
balance analysis, describing how, if and when the water demand is met with the
available water supply.

The focus of this workshop will be mainly on the water supply component, and more
specifically, on the quantification of the surface water available at the catchment level
through (net) precipitation and run-off. Aspects related to water demand will be dealt
with only to account for the water losses produced by vegetative water use (i.e. water
lost through evapotranspiration of vegetative land cover and/or crop water
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requirements) but not for aspects related to anthropogenic domestic and industrial
water demands.

Available water resources at the catchment level are usually quantified in term of river
discharge series. To calculate river discharge, a number of input parameters need to be
known to ultimately compute surface water flow. These parameters are:

Precipitation;

Potential evapotranspiration;
Crop water factors;
Topography;

Soil types;

Land use and land cover types.

SN NN NN

This workshop will specifically focus on these parameters to carry out the hydrological
analysis for the selected river basins.

Precipitation is the main input factor determining the gross amount of water received
from the atmosphere. Potential evapotranspiration determines the amount of water
which returns to the atmosphere depending on location-specific factors such as wind
speed, solar radiation, surface and air temperature. Crop water factors determine the
amount of water used by crops during their growing stages. Catchment morphology
determines the direction and speed of flow based on slope patterns. Soil types
determine infiltration and water saturation rates, and therefore directly determine run-off
formation and accumulation. Ultimately, land use and land cover determine vegetative
water demands and, to a more limited extent, the speed of the rainfall to runoff
transformation process.

1.2.2 Freely available global datasets for the analysis

All of the above-mentioned input factors are nowadays freely available from regional
and international research institutes that work in the field of natural resources
management and spatial and atmospheric interactions and are often available at the
global scale, hence these datasets are often referred to as global datasets. Global
datasets are information-rich databases that provide public and private users with
detailed and sector specific quality input for data retrieval and management. Figure 1.1
shows an example of the number and type of global datasets that are nowadays
available for environmental modeling.
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Figure 1.1 Example of global datasets for environmental modelling.

Source: http://spatial-analyst.net/wiki/index.php?title=Global_datasets

A good example of a global widely-used dataset is the FAO Harmonized World Soill
Database (HWSD), which is a metadata pool of information on soil types
characteristics, occurrence, and geographical distribution at the global scale.

The number and types of global datasets which can be used to run a hydrological
analysis varies. NASA, FAO and ESA provide for example good quality sources. Some
of them will also be used in this workshop. In this manual, in each section describing
the data input required for our hydrological analysis, a brief description of the alternative
available sources of data is mentioned, although the list provided is not comprehensive.

During this workshop, the global datasets that have been selected to perform the data
preparation and run the hydrometeorological assessment are:

. Precipitation data from the NASA Tropical Rainfall Measuring Mission (TRMM);

" Topography data from the NASA Shuttle Radar Topographic Mission (SRTM);

" Land cover data from the GlobCover database of the European Spatial Agency
(ESA);

" Soil data from the FAO Digital Soil Map of the World (DSMW);

" Evapotranspiration data from the Consultative Group on International Agriculture
Research (CGIAR)

The individual modules of this workshop will explore these global datasets with the aim
to combine them into the WFlow hydrological model that will be used to generate the
river discharge series.
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Whenever possible, it is always good to compare the information obtained from the
global datasets with available measurements or other global data sources. Depending
on the quality of the measured data, this comparison will allow you to make critical
judgements on the reliability and precision of the information you are analyzing. This is
an important point to ensure data quality management.

1.2.3 Freely available software for the analysis

To be able to generate discharge series for the selected river basins, this workshop will
focus on the use of the freely available GIS software Quantum GIS (or QGIS) used in
combination with WFlow, a distributed hydrological model built using a dynamic GIS
language called PCRaster.

2ot - -
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Quantum GIS will be used for the data preparation phase, while WFlow will be used for
the generation of the river discharge series based on the input prepared with QGIS.

WFlow has been developed by JaapSchellekens from Deltares, and is an open source
(GPL) distributed hydrological model distributed at no cost and without any warranty.
More specific information related to the model functioning and characteristics is
provided in Chapter 7. For further information about model’'s acquisition please contact
Mr.JaapSchellekens at Jaap.Schellekens@deltares.nl.

Participants will be introduced to the use of Quantum GIS in Chapter 2, and will use its
functionalities in Chapters 3 to 6. The data preparation to run WFlow will mostly be
performed with QGIS. Soil reclassification will be performed by making use of both
QGIS and Excel.
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2  Working with Quantum GIS

In this chapter participants will be introduced to the use of the freely available GIS
software Quantum GIS.

Quantum GIS, or in its short form QGIS, is an open source Geographic Information
System software which has been developed by the Open Source Geo-Spatial
Foundation (OSGeo) and which supports several vector, raster, and database formats,
such as for example ESRI shape files and GeoTIFF files.With QGIS it is possible to
view and overlay different data formats (i.e. vector and raster data) without conversion
to a common format. Most of the functions available with non-open source software (i.e.
ArcGIS) are available within QGIS.

On the internet, you can access different fora where users share their knowledge about
the use of QGIS. An example of such a page is:
http://www.baruch.cuny.edu/geoportal/practicum/gis_prac_intro.html edited by Frank
Donnelly. This website provides quite an amount of useful information on the use of
QGIS. Some of the content of this workshop has also been extracted from this
webpage.

An overview of the different formats used for each of the module components we will
analyze is given in Table 2.1 below:

Table 2.1 Types and formats of used input data.
Data input Source Format Resolution (m) Extension
Precipitation TRMM Raster Approx. 28000 .map
Topography SRTM Raster 90 if / .asc
Land cover GlobCover Raster 300 tif
Soil types FAO Vector - .shp
ETpot CGIAR Raster 1000 tif

Please note that to make use of the raster functions described in this manual, your raster
files need to be in GeoTIFF (.tif) format. If the raster file is in a different format, convert
the file via Raster -> Conversion -> Translate (convert format) (see also Section 2.4.5).

21 Installation of QGIS

Quantum GIS can be downloaded from http://ggis.org/. During this workshop, we will be
using QGIS beta version 1.9.90. A beta version is a development version of the latest
stable release of the programme which includes additional functionalities as compared to
the standard version. The version is available on the same website by browsing the
following path: Home page -> Downloads -> Master -> Download OSGEO4W Installer ->
(use) Advance Install -> install qgis-dev.

Should you download the programme directly from the internet, in the Select Packages
window, once you are on the Desktop menu select the ggis-devpackage, click next and
finalize the installation.



Use of Global Datasets for Hydro-
Meteorological Analysis in Areas with 1201430 May 2012

Sparse Data

Preliminary

Deltares

We have already prepared for you the installation package containing all the required
executables and the folders containing the required input data. These folders are
available on the USB stick we distributed to you.

Installation of QGIS without internet access

To proceed with the installation of QGIS without internet access, follow accurately the
instruction provided below. Please make sure you do not skip any step described in the
manual. This might result in incomplete importing of files or parts of the application, and
can cause reduced functionality of QGIS during data elaboration.

These installation instructions are written for Windows, and have been tested with
Windows 7.

On your USB stick, in the Installation directory you find 4 folders, namely:
- 0SGeod4W

- 0SGeo4Wstartmenu

- Shortcuts

- Python

Copy the folder OSGeo4W to your C drive. Just copy the folder in the drive and not in
another folder (i.e. Program Files) cause this may cause operational problems later on
while running the application. Most of the required installation material is contained in this
directory.

Now you can choose if you want to start QGIS through a shortcut from your desktop or if
you prefer to start it from your computer Start Menu.

To be able to use the shortcuts, copy the shortcut files contained in the Shortcuts folder
(so not the folder itself but the files contained in it) to your desktop.

To import the program in your Start Menu, access from your USB stick the
OSGeo4Wstartmenu folder and drag it to the Programs directory accessible through the
Start menu as shown in the picture below.

L&) -

[ T o I ]
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After following these instructions, you can now run Quantum GIS (1.9.90) from your
desktop by double clicking on the desktop icon or, from the start menu, by selecting the
following path: Start->Programs 2>0SGeo4Wstartmenu 2>Quantum GIS (1.9.90). This
procedure gives you access to the basic functionalities of Quantum GIS. However,
since we are using a beta version of the programme, we can make use of additional
functionalities for GIS data management by selecting and importing a number of
important plugins. Plugins are optional applications that render available additional
functionalities for data management.

Plugins are available directly from the internet, and the available options are visualized
through the Plugins menu when opening QGIS as shown in the figure below.

& Quantum GIS d5431b3

Fil=  Edit Miew Lawer Settings | Plugins | Wector Database Rasker

O . ¥ i ¥ . Fetch Python Plugins. ..
1 - E B W

{5 Manage Flugins. ..

LY m%
ElEIERERE

Google Lavers
Layers Mesuaring Yegetation Tool
Raster Colours

GRASS

The selection Fetch Python plugins allows you to browse new available plugins that are
supported by the programming language Python. The selection Manage Plugins allows
you to select which available plugins you want to render active while working with
QGIS, and which ones are not needed and therefore can remain available but
hibernated.

R

mmggis

r* ¥ ¥ w ¥ ¥

Some of the plugins we will use are already contained with the downloaded version of
QGIS. Additional plugins useful for the data preparation have been downloaded from
the internet and saved in the Python folder provided with the USB stick. Follow the
procedure described below to render the available plugins active for use with our
version of QGIS.

In one of the two following paths: C:\users\<name>or C:Documents and
Settings\<name> search for the folder named .qgis. Where the folder is located will
depend on the version of Windows that is installed on your computer.

Access the Python folder from the USB stick (contained in the Installation folder), and
copy it into the .qgis directory. Close all the open folders and restart Quantum GIS.
From the Main menu go to Plugins>Manage Plugins and select all the available
plugins in the list and click ok.

10
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{} QGIS Plugin Manager 2] ]

Fiter | |

To enable | disable a plugin, click its checkbox or description

= 1-Band Raster Colour Table ¥1.x (1.1.0) E

E =
(% - Thig plugin creates colour tables for a 1-band raster from preset colour palettes and colouring
= methods.

Installed in Plugins menu,/toolbar

Add Delimited Text Layer
x| Loads and dis?—lays delimited text files containing x,v coordinates
Installed in Layers menu;toolbar

Coordinate Capture
x| + Capture mouse coordinates in different CRS
Installed in ¥Yector menu;/toolbar

I Diagram Overlay

L|
% E |D A plugin For placing diagrams on vector lavers
= = Installed in Plugins menu,/toolbar

Dxf25hp Converter

% 2. Converts From dxf to shp file Format
Installed in ¥Yector menu,toolbar

Flugin Directary: i fOSGeod W apps/ggis-dew/plugins

| ok || seectal || Clearal || concel |

With this last step you have just installed all the functionalities required to start working
with Quantum GIS.

Once you have QGIS installed on your computer and you have started the program, the
initial screen will appear as from the image below (except for the map):

G Quantum GIS 1.5.0-Tethys =19
File Edit Wiew Lawer Settings Plugins Help n

J=REdd s ﬁﬁi’é’&mﬂgf »
o QX Q QRPO PRHE > v

Layets (&)= / L
% .= nyc dyr _colleges E
e
B ‘ nyc_facilities

B- % n nyc_greenspace

=N

=R . nyc_counties_2008

Crueruiew @@

[5]

&

I % ’

e

6 |:oordinate | -73.8370,40.8352 | icale || 1:126108 €3] Render |[]

Figure 2.1 QGIS initial screen overview.

Source: http://www.baruch.cuny.edu/geoportal/practicum/gis_prac _2.html
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In Figure 2.1, number 1 to 6 corresponds to: 1- Menu bar, 2-Tool bar, 3-Map legend, 4-
Map View, 5-Map Overview and 6-Status bar. Play around the menu and tool bars and
the map functions to get familiar with the available options.

Getting started using QGIS

To start working with QGIS, create a new project and name it after your river catchment
ID name provided in Section 2.1 and todays date: i.e. EDB 13.02.2012. This is done by
entering the data from: Settings-> Project Properties -> General -> Project title.

£ Quantum GIS 1.7.2-Wroclaw

File Edit ‘iew Lawer Settings Plugins ‘Vector Raster Help

B dd o RRFELPH
MEIQHQLWQWEW@‘%ﬁ
n“%@ﬁ@’q‘anr‘%\:jkj

Once you have saved your project, you need to import the input layers that will be used
for data analysis and preparation. We will discuss the difference between the types of
layers in Sections 2.3 and 2.4. However, in order to be able to work with the Coordinate
Reference System exercises described in the next section, and to become familiar with
the functionalities of QGIS, we will briefly explain here the procedure to import layers in
a project.

By making use of the tools bar, import the layer containing Indonesia’s administrative
boundaries contained in the Administrative Boundaries Folder on your USB stick. The
file to be imported is named IDN_admZ2.shp.

The commands to import layers in your projects are located at the top of your QGIS
toolbar as shown in the picture below.

You will soon notice that QGIS gives you the option to choose between vector, raster
and other format of data to be imported. Select the appropriate option based on the
layer type you are importing (IDN_adm?2 is a vector layer). After this operation, the layer
should appear in your map view. If it does not appear, right click on the layer name on
the map legend and select zoom to layer.

 Quantum GIS 1.7.2-Wroclaw - WS EDB

Fle ER Vew Layer Settings Phgns Raster Hep
1o CPLRPE 7dd o fo
AN AUAAAATD «F0S I [BAARRAAR PO
CaQBORBRIIAKRAIC T s IS ORR o
Layen 8x

You are now ready to start working with QGIS on the different modules of this
workshop. Good luck!

Deltares 12
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2.2 Background information on the Coordinate Reference System’

A coordinate reference system (CRS) is a coordinate-based univocal mapping system
that allows for referencing spatial information in a plane by making use of a set of
coordinates (X, Y, Z) and/or latitude/longitude and height (INSPIRE, 2009). While
working with GIS maps, the use of the same CRS ensures that the projected data use
the same spatial reference.

Figure 2.2 World map of UTM zones

Source: http://en.wikipedia.org/wiki/File:Utm-zones.jpg

In the majority of cases, spatial reference is provided by using a system of equidistant
lines known as Parallels (running West to East) and Meridians (running North-South),
which define latitude and longitude specific for any given location. The range of latitude
is [90° North — 90” South], that of longitude is [180° West — 180° East]. To measure the
location of a specific point in the plane, we measure the distance between the location
of this point and the reference latitude and longitude lines in our system (the Equator
and the Greenwich Meridian, both at 0° latitude and O° longitude respectively). Such a
distance is measured in degrees (for specific information on how to transform angular
measurements in metric distances refer to the next section).

The most widely known coordinate reference system based on latitude and longitude is
the World Geodetic System - 1984 (WGS 84). A geodetic datum defines the
reference systems that describe the size and shape of the earth?

An alternative spatial reference system to geo-reference a point in a plane is the widely
known Universal Transverse Mercator (UTM) system, which defines points in a map
based on a 2-dimensional Cartesian coordinate system represented by cells organized
in a grid characterized by unique values. In the UTM any location can be associated
with a reference grid cell based on its spatial location. Figure 2.2 shows the grid cell

" A good and well described source of information on the functioning of QGIS, and on working with GIS in
general is: http.//www.baruch.cuny.edu/qeoportal/practicum/qgis_prac 4.html). Part of the content of this
manual also makes use of this source

2 Source: http://www.colorado.edu/geography/qcraft/notes/coordsys/coordsys.html, accessed on 25.01.2012
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system of the UTM for the entire world. A selection of the UTM grid cells for Indonesia
is on the other hand shown in Figure 2.3 below. As it can be seen from this figure, the
whole of Indonesia is covered by 18 UTM zones, ranging from 46N to 54S. The
nomenclature N and S stands respectively for North and South of the Equator.

Figure 2.3 UTM zones for Indonesia.

General information on angular measurement system

In a GIS environment distances and coordinate reference systems are often defined
based on angular measurements (degrees, minutes, seconds), rather than a linear scale.
This is because of the subdivision of the Earth in a system of coordinates defined by a
reticulate of horizontal and vertical equidistant lines known as parallels and meridians.
Because the Earth surface is not a perfect sphere, but rather an oblate ellipsoid (2 of its
3 radius are of equal length), the equatorial circumference differs from the polar
circumference. The values of these two circumferences are:

] Equatorial circumference: 40,075.017 km

. Polar circumference: 40,008 km

Polar circumference Pole
40,008 km (24,860 mi) —— ~—

North Pole £ =3 N\

\
I \
1 \

—~—— +
Geoidal \‘ 12,756 km (7926 mi) l,
bulge 1\ I /i

Equatorial circumference R v >
40,075 km (24,902 mi) e e

Figure 2.4 The shape of the Earth®

In angular measurements, a degree is defined as 1/360 of the circumference of the
Earth, 1 minute as 1/60 of a degree, and 1 second as 1/60 of a minute. A distance in 12
angular seconds is normally referred to as 12 arcsec. Based on this definition, the
following example is given for the computation of an equatorial distance:

3 Source: http://www.sci.uidaho.edu/scripter/geog100/lect/01-foundations-of-geography/chap- 1-part-2-earth-
Sshape-lat-long-time.htm, accessed on 16.01.2012
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1 arcsec (=) = 40,075.017 Km* 1/360degrees *1/60min * 1/60sec = 0.0309 Km = 309 m

This is the procedure you can use to determine the equivalence between angular and
linear measurements.

Setting the CRS of your project

When you start a new empty project, under Settings -> Project Properties you can define
the CRS for your project. During this workshop the CRS we will be using is the World
Geodetic System - 1984 (WGS 84, EPSG: 4326). While working with QGIS and
importing layers, make sure you are always working on this set of projections.

On the other hand, when you import existing layers to a project, QGIS automatically
recognizes the projection system used in the imported layer and uses it to define the
default CRS for the project. This occurs when the imported layer already has defined
projections (i.e. a shape file with the .prj file).

&l Project Properties = =i

4 General .:} Coordinate Reference System (CRS) | L Identifiable layers | WS Server

|%| Enable 'on the fly' CRS transformation

Filker

Recently used coordinate references systems

iCoordinate Reference System

Wiss &4 J World Mercator

W3S G4 [/ UTM zone 545

WG5S 54

Google Mercator

Popular Visualisation CRS § Mercator

| Buthority 10
EPSGi3395
EPSGi32754
EPSGi4325
EPSG:o00913
EPSGi378S

] |

Coordinate reference systems of the world

G
Hide deprecated CRSs
=]

iCoordinate Reference System IAuthority 10

£ woiral 1879 {Paris)

EPSGi4521
EPSG:4760
EPSGi4322
EPSGi4324
EPSGi4326
IGNF W GEET2GE
EPSGi4733

EIE
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- Wallis - Uyea 1978 {MOPTE)
s world Geodetic System 1954

IGNF W ALLFEGEED
IGMNF: W G554G

K10}

KRl

]
+proj=longlat +datum="%3584 +no_defs

N

Note! WGS84 also exists under the Projected Coordinate System (PCS), which uses a
different coordinate system from the Geographic Coordinate System (GCS) just
described. You can distinguish between the two CRS by spotting the difference
between the coordinate library European Petroleum Services Group (EPSG) codes.
The difference between the two reference systems is explained in the text box below.
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On the difference between Geographic and Projected Coordinate Systems

Collectively, when you have these three elements: a spheroid or ellipsoid, a datum, and
a coordinate system, you have a so-called Geographic Coordinate System (GCS). The
terminology is confusing, as a coordinate system is one part of a geographic coordinate
system, and some systems are named based on the datum they use. For example,
WGS84 (World Geodetic System of 1984) is the most common GCS and uses the
WGS84 spheroid, WGS84 as a datum, and latitude and longitude as a coordinate
system. WGS84 is used by the Global Positioning System (GPS) of satellites and thus
by individual GPS units as a default, and is commonly used by online mapping
applications. There are other systems; in North America NAD83 (North American
Datum of 1983) is widely used, particularly by government agencies. It uses GRS 1980
as a spheroid, NADS83 as the datum, and lat and long as the coordinate system.

If you add a map projection as the fourth element to the spheroid/ellipsoid, datum,
coordinate system trio, you have a projected coordinate system (PCS):

Projection: Map Projections are mathematical systems for taking the three dimensional
earth and transforming it to a flat two dimensional surface. There is no way to take a 3D
shape and accurately represent it on a 2D surface, so map projections are designed to
preserve one quality of the earth - area, shape, or distance/direction, or are created as a
compromise to make the earth appear the way we expect it to appear on a flat surface.

It's important to understand the distinction between a GCS and a PCS, because when
you go to transform a layer or define a projection these two systems will be stored or
organized in the software separately, under different menus or tabs. You should use a
GCS when you're doing analysis, measuring distances, or working in a relatively small
geographic area. You shoulduse a PCS when you're creating a thematic map or need to
have a certain quality of the earth (area or shape) preserved.

Source: http://www.baruch.cuny.edu/geoportal/practicum/gis prac 4.html

You can check the coordinate reference system (CRS) of your layer by right clicking on
your layer and choosing Properties and navigating to the Generaltab. If no CRS is
available you can specify it here.

2.3 Working with vector layers

A vector (shape) layer is a digital map that represents points, lines or polygons in a
system of coordinates. In a vector layer, the user can draw and define vectors and
perform a large number of other operations directly on all the vectors within this layer,
or only on a selection of them. A vector layer has an attribute table where all the
attributes of the features in the layer are described. The attribute table can be used to
make sub-selections or to create queries for refinement of features identification. The
most common format of a vector layer is a shape file (.shp), but other vector formats do
exist (for instance .bna). An example of a vector layer is the administrative boundaries
layer for Indonesia, which displays the administrative boundaries units as polygons. The
associated attribute table of the layer is also shown in the figure below.
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€ Attribute table - IDN_adm2 : 0 / 394 feature(s) selected 1ol x|
B 150 MAME_D D1 NAME_1 .2 NAME 2 |MaM|dar | Hasc 2 | ooz TYPE_2 SMGTYPE 2| VALIDFR_2 VALIDTO 2 [~

o 1031 IDN Indonesia 1264 | Jawa Tengah 15418 |Batang ] M. [IDITET |MULL  |Kabupaten Regency | Unknown Presant

1 103 IDN Indonesia 1264 | Jawa Tengah 15419 |Blora M. |N.. [IDJTEL |MULL |Kabupaten Regency | Unknown Present

2 103 |IDN Indonesia 1264 | Jawa Tengah 15420 |Boyolali M. M. |IDJTEO |[MULL  |Kabupaten Regency | Unknown Present

3 103 IDN Indonesia 1264 | Jawa Tengah 15421 |Brehes N M. [IDJTER |MULL | Kabupaten Reqgency | Unknown Present

4 103 IDN Indonesia 1264 | Jawa Tengah 15422 |Cilacap ] M. [IDITCI |MULL  |Kabupaten Regency | Unknown Present

5 103 IDN Indonesia 1264 | Jawa Tengah 15423 |Demak M. |N.. IDJTDE |[MULL |Kabupaten Regency | Unknown Present

6 103 IDN Indonesia 1264 | Jawa Tengah 15424 |Grobogan Gr.. M. |IDJTGR  MULL | Kabupaten Regency | Unknown Present

7 103 IDN Indonesia 1264 | Jawa Tengah 15425 | Jepara N M. [IDITIE  MULL  |Kabupaten Regency | Unknown Presant

5 103 |IDN Indonesia 1264 | Jawa Tengah 15426 |Karanganyar  |M.. |M.. |ID.JTKA |MULL | Kabupaten Regency | Unknown Present

a 103 IDN Indonesia 1264 | Jawa Tengah 15427 |Kebumen MN.. M. IDJTKE MULL | Kabupaten Regency | Unknown Present ﬂ

+ 1015 10N Indnnesia 1264 | 1awa Tennah 15427 [Kendal o IM Tk (M lkabynaten Renenre |l inknown | Prasant 1=

4 & | G1v

A REEREZEEEE E - ) B

|| Show selecked only || Search selected only (3] Case sensitive ﬂhdvanzed search | | > |

When you use an existing or create a new shape (.shp) file, there are other 3 files
automatically associated with the shape file. These files are:

" .shp file containing the geometry of the shape
" .shx file containing the shape index file, n index of the geometry
" .dbf file containing the attributes database of the layer’s features

Additionally, also the following files sometimes exist:

" .prj file containing the projections of the layer

o .sbn and .sbx files containing the spatial index of the features

" .shp.xml file containing the XML metadata®

" .qpj file containing the layer’s projections created by QGIS

The following exercises will teach you how:
1. to create a sub-selection based on attributes from a vector layer;
2. to create a selection by drawing a polygon around a feature from a vector layer.

2.3.1 Exercise: how to create a sub-selection from a vector layer based on its
attributes

To create a selection from a vector layer, we will be using the FAO Digital Soil Map of
the World (DSMW). From this global map covering the soil types of the entire world we
will create a clip to select only soils occurring in Indonesia and Papua New Guinea
(PNG). Papua New Guinea is included here because of its neighboring position with
Indonesia and the Merauke study area is located along this border. In addition the
‘union’ function of QGIS can be practiced.

With this exercise you will learn to use the following QGIS tools and/or functions:

4 Based on : http://www.baruch.cuny.edu/geoportal/practicum/gis_prac_2.html, accessed on 26.12.2012
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- create a new vector layer from a selection of an existing layer;
- use the CRS selection to set a new coordinate reference system;
- use the Union tool to merge vector data from different vector layers

To achieve our final objective, perform the following commands:

Run QGIS.

Create a new project and name it Data preparation.

Import the IDN_adm?2 layer (in Catchment boundaries/lGADM Admin boundaries folder),
and the Digital Soil Map of the World (DSMW) layer (in Datasets/Soils/Digital Soil Map
of the World folder).

Move the administrative layer on top of the DSMW layer to visualize the overlapping.
Open the attribute table of the DSMW layer by right clicking on the layers name.

From the DSMW layer, make a selection for Indonesia based on its reference country
code (101 for INDONESIA and 168 for PAPUA ANDNEW GUINEA, CNTCODE column
or via the COUNTRY column), and create a new layer. TIP: You can use the search
function! Follow the same procedure to create a layer called DSMW PNG (Papua New
Guinea).

555 PAPLS AMD MEW... |

@ | Lookfor 168 N CNTCODE =
® Case sensitive Advanced search ?
T EEd s RRPEPLPIURBPI 730K

R I5CLU2 ERMAFROST CHTCODE CHTMAME SOKM COUNTRY  © |*
AR - 0 : 100 1N & 170 | INDIA 2
1705+ 0 100 |1 133 | INDIA

= @ IDN_ad t70es a 100 |1N 12 INDIA
] 17056 0 100 |1 146 | INDIA

= % @& DsMwl 17067 ?

= 17068 -
17069
17070
17071
17072 .
17073 :
17074
17075
o Coage|

To create a new vector layer, use the Save selection as function by right clicking on the
original layer (see screenshot below).
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Y Quantum GIS 1TZ7dc63

T HEEHdS s RRPERPF
BN N BMAYAGOEOE S
A PORB®RI A D

Layers Fl

2§ 1DN_adm2

\wt, Zoom to layer extent
Show in overview
& Remove
et laver CRS
Set project CRS from layer
=] open attribute kable
# Toggle editing

Save as...

Query. .,
Shows Feature count

Properties
Rename
Add group
¥ Expand all
[l collapse &l
Update drawing order

Choose as format ESRI Shapefile (default output format is Keyhole Markup Language
(KML)). It is strongly advised to create a new folder called My maps or Data preparation
in which to save your newly created maps. This will help you not to confuse the input
dataset maps with the ones you will create. Always save your new maps in this folder.
In addition it is useful to include the projection in the newly created filename. Save your
new vector layer therefore as DSMW Indonesia — LL.shp (LL stands for Latitude-
Longitude used for the WGS84 projection).

& Save vector layer as...

Format | ESRI Shapefile -
Save as 070228 version){LL/DSMW Indonesia - LL.shp
Encoding  UTF-8 -
CRS Criginal CRS Erowse

DGR, creation aptions

Data source

Layer

Skip attribute creation

(0] 4 Cancel Help
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Import the new layers into QGIS and remove the DSMW layer. Finally, by using the
Union tool from the Vector ->Geoprocessing tools menu, we can create a new layer
containing only the soil maps of both Indonesia and Papua New Guinea. Use one of the
layers as Union Layer and the other one as Input vector layer. Name the new layer
DSMW Indonesia+PNG — LL.shp. Click yes if you are asked if you would like to add the
new layer to the TOC (Table of Contents). Close the Union tool.

\z\ectorl Raster  Click-fu

Input veckar layer

= Analysis Taols N -
= T e .?} (X] DSMW PG - LL ~

B Research Tools
@

Use only selected Features

€8 Convex hull(s) l C 1 e
i nicn layer

R Bufferis)
DSMy Indonesia - LL -

& Intersect :
Use only selected Features

(B Symetrical difference

5 Geometry Tools
[-&¥ L Data Management Tools

4 fTools Information

(@ Clip Qukput: shapefile
@ piffersnce wld (070225 version){LL/DSMW Indonesia-+PNG - LL shp
@B Dissalve

[I 0% ] Ok Close

The resulting map will look as follows (perhaps a different colour is used):

Remove the DSMW Indonesia+PNG— LL and DSMW PNG- LL layers from your
project.

2.3.2 Exercise: how to reprojecta vector layer

As mentioned before, WFlow requires all input maps to be in raster format. Moreover,
we also need to have these maps in the UTM CRS. In this exercise you will learn how
to reproject the selection of soils for Indonesia layer (DSMW Indonesia - LL) from
WGS84 to the UTM projection.

From your layer DSMW Indonesia— LL right click and select the option Save as.
Change the CRS to the UTM projection used for your catchment (e.g. UTM 54S for
EDB) via the browse button (see screenshot below) and Save the new shape file
including the projection in the filename (e.g. DSMW Indonesia — UTM54S.shp) and click
OK.
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i Save vector layer as...
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Farmat  ESRI Shapefile
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Encoding | UTF-8 -
— |
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DGR, creation options
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Skip attribute creation

Control rendering order oK Cancel Help

o B T N T T N A

If your catchment area includes more than one UTM zones, make a best estimate on
which selection is the most appropriate based on the areal coverage of the UTM zone
on your catchment. Click OK.

Import the newly created DSMW Indonesia — UTM54S layer into your project and check
— by comparing with the original layer — if the new projection in UTM has been correctly
processed. It appears that the imported layer is not visible. Why?

Try and visualize the layers. TIP: right click on the layer! You can check if your map has
been projected in the new CRS by inspecting the values of the coordinate appearing on
your Status bar. A layer projected in UTM shows the coordinate system in metric units,
while a layer projected in a WSG84 system geo-references points in a map in a lat/long
(latitude longitude) projection.

5| coordinate: | -3274820,6875598 [

Remove the DSMW Indonesia — UTM54S and DSMW Indonesia — LL layer from your
project.

2.3.3 Exercise: how to create a sub-selection from a vector by drawing a polygon
around a selected feature

In this exercise you will learn to use the following QGIS functions:
- new layer
- toggle editing

It is worth noting that for the purposes of this workshop we will not need to perform this

operation. The exercise is presented only to provide some additional methods on how
sub-selection from vector layers can be done.
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Import the WS_regionlayer. Within this layer the Wilayah Sungai (catchments) in
Indonesia are included. The file is located in the Catchment boundaries folder
(Watersheds Indonesia (2010)) on your USB stick.

From this layer, identify the catchment assigned to your group, and work on this
catchment. As an example, we will describe here how to perform this exercise by using
the Einlanden-Digul-Bikuma (EDB) catchment in Papua, and therefore all the
nomenclature definition for the naming of the new layers will make direct reference to
the EDB. Please remember to use a different nomenclature based on the name of your
assigned catchment.

To identify the location of your catchment, either use the attribute table of the
WS _region layer, or use the information tool from the Tools Menu (see figure below)
and clicking on the map. Following the same procedure as described in the exercise of
Section 2.3.1, create a new vector layer from the WS_region layer, and name it after
your catchment short ID name including the projection. For the Einlanden-Digul-Bikuma
catchment the file name to be typed is WS EDB - LL..

AL

h

Zoom to the extent of your newly created catchment layer.
Import the DSMW Indonesia+PNG — LL layer.

You will now create a sub-selection polygon feature from the DSMW Indonesia+PNG -
LL layer embracing the EDB catchment by including also parts of PNG that are relevant
for the analysis. For this first step, we will just perform a simple selection based on no
specific criteria. In the next section, we will draw the polygon feature by taking into
account the influence played by elevation.

When you import the layers, this is how you should visualize them:
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Notice that the layers do not have a 100% overlap with the coastal area. Check if the
layers are set to the same reference coordinate system, by right clicking on the layers
name in the layers map, and by selecting Properties -> General as shown below.

{3 Layer Properties - DSMW Ind+PNG 2 x|

[ ‘y”style | 7 Labels | Fields ‘ ’\ General @Metadata | @‘Actions | ‘éJoins | TIL]Diagrams | TIL]Overlay

Options

Display name [DSMW Ind+PMNG ] Display field
Edit LT | | E Create Spatial Index
Init function [ ]
EPSG:4326 - WiES 54 ] Specify CRS

You will notice that both layers are set to the same CRS. Although visually the
difference does not seem to be relevant, by using the measuring tool (up-centered
circle) and by applying it to any point in the map where there is a bad overlapping, you
will notice that discrepancies are in the order of 1000 meters or more. In the example
provided below, the spatial difference in the bottom-left corner amounts to around 6 km.
In order not to lose relevant data, we want therefore to create a polygon feature that
includes all of the terrestrial areas shown in the layers.

Foumow e (ESlPRR 4 B W@ =

® 2O

3] Ellipsoidal

| Segments (in meters) I

5,561.650
585,970

6.148 kmn |

| [ e |

You can create a polygon from a vector layer by selecting Layer -> New -> New shape
layer. When the new screen pops-up you have to define the characteristics of the layer
(for Type select Polygon, for Type in the New Afttribute selection select whole number,
give the name of the new attribute WS EDB and then select add to attribute list, click ok).
Save the layer with name WS EDB polygon. Don’t forget to set the CRS of your
catchment! For this exercise we will use WGS84.
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The layer will appear in your layers map. Right click on the layer's name and select
Toggle Editing to start editing your feature based on your criteria of selection. Start
creating your polygon around the WS EDB catchment by clicking around the contour of
the WS EDB border lines. When you have finalized your editing, right click with the
mouse to stop the toggling, give an id and save the file. Upon completion, the WS EDB
polygon should look like the pink contour line shown in the picture below.

24 Working with raster layers

A raster layer is a digital map containing information organized in grid (square) cells.
Depending on its resolution — which represents the size of each grid cell - a raster layer
is made up of a varying number of cells. The higher the resolution, the greater the
number of cells (or pixels) forming the grid. In a similar way, the lower the resolution,
the coarser the detail of the information and the lower the number of grid cells in the
layer.
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In a raster, each cell is associated with one or more values describing the attribute of
the layer (i.e. elevation), although no attribute table exist for raster files, a raster layer
can be linked to a shape file having the attribute table, and hence providing a higher
degree of detail on the data being visualized. This is for example the case for the
Harmonized World Soil Database (HWSD) dataset, where soil information is provided at
a global scale in a raster environment, and then the linkage to soil physical
characteristics is accessible from a connected vector dataset accessible through the
HWD Viewer tool. The tool can be downloaded from:
http://www.iiasa.ac.at/Research/LUC/External-World-soil-database/HTML/index.html.

The raster layers we will be using during this workshop are:

- Elevation (SRTM);

- Precipitation (TRMM) and Potential Evapotranspiration (CGIAR);
- Landcover (GlobCover).

To render the data processing and management in QGIS faster, for each of the above-
mentioned datasets we need to work with selections representing only the data for
Indonesia. This means that we will perform a selection on the global datasets and
create new datasets only covering Indonesia. From these new layers we will then make
a subsequent selection to select only the spatial extent related to our river catchments.

Selection of land cover and land use types for Indonesia from the global GlobCover
map is described in Chapter 4 while precipitation data from TRMM has already been
prepared by selecting the input for Indonesia only. In the following exercise we will
make a raster selection using the SRTM elevation map. The example provided uses
again the EDB catchment. You should work on your assigned catchment (therefore
using the corresponding input maps) following the instructions provided for the EDB
example.

2.4.1 Exercise: how to visualize a raster layer

Before we are going to create a selection from the SRTM elevation raster layer for your
catchment we are first going to import and visualize the SRTM tiles for your catchment.
For the EDB catchment the SRTM layers are: srtm_64_13, srtm_64_14, srtm_65_13,
and srtm_65_14 (for Java srtm_58 14 and srtm_59 14). When prompted for the
projection choose WGS84 in the geographic coordinate systems as shown in the
screenshot below:
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Define this layer's coordinate reference system

This layer appears to have no projection specification. By detault, this layer will now have its projection set to that of
the project, but you may override this by selecting a different projection below.

Filter | |
tly used coardinate references ems
Coordinate reference systems of the world || Hide deprecated CRSs
Conrdinate Reference System |ty 0 =
- vioirol 1875 (Paris) EPSG:i4E11
Uil 1679 EPSG467L D
- vioiral 1879 (Patis) EPSGi4E21

- WGS 66 EPSG:4760

- wtallis - Uvea 1978 (MOPZ8)

IGHFWALL7EGED

- \world Geodetic System 1984 TGENFWESE4G
Hian 1980 EPSG:4610
- Yacare EPSG:4305
- Yemen NGNIE EPSG:4163 >
Eh| L ] 4]
+proj=longlat +datum=WES84 +no_defs ]
[ o ]| cacel || e |

Also import the WS EDB — LL layer created in the exercise provided in Section 2.3.3.
Move the WS EDB — LL layer on top of the SRTM layers to visualize the overlapping.
The resulting visualization in the map canvas is the following:

In order to better visualize the elevation difference in the projected area, we are now
going to change the layout of the layers by modifying the color settings. For each layer,
change the color form the grey to the freak out format. You can do this from the layer’s
right click selection Properties -> Style.

Now change the visualization of the WS EDB map from Simple fill to Simple line from
the Style menu of the layer’s Properties tab as shown below.
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This operation will allow you to visualize the boundary conditions of the WS EDB and
comparing them with the overlaying SRTM layers. After these changes, the result
should be the following:

TR _ o

By looking at the map layer, you will notice that, one of the 4 SRTM layers has
something wrong with it. What is it?

To find your answer recall that for the SRTM layers different colors correspond to
different elevation ranges. You might come to the conclusion that the elevation ranges
for the 4 layers are not the same. To ensure homogenization of the SRTM data, we
need to set a same reference scale for all of the 4 layers.

2.4.2 Exercise: how to homogenize the view settings of different layers to a
common format

With this exercise you will learn how to create a map visualization style to be used as a
default for each of the different layers that need the same formatting style. In this
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example, the exercise will focus on the formatting of the elevation ranges of the SRTM
layers to a common color and range scales that can be used for the different SRTM
layers selected for our catchment area.

From the layer’s Properties, Style tab, selectColor Map. Move to the Color Map tab and
define a range of colors by selecting 20 as the number of entries from the generate new
color map tab. Once you have created the 20 ranges, assign to each of them a value to
them to highlight the elevation differences especially for the low and high elevation
areas. You can change the values of the ranges by double clicking directly on the value
shown in the Colormap table as shown in the picture to the right. Click on Apply.

(( Layer Propesties - srtm_b4_13 : Xix
e - e o { ‘|
w Sty Transparency " Colorrmeg \, Gereral I Metasets |'
Cokn g
Cobor wtorpbatn lnew =
LM wtry Duiete otry Sort Pandl =« 4 4

Generste new cokr map

Nurber of ertres 20 5 Classhcation mode Laudtervd Qassly
Restire Def st Styvie Save As Def matt Luad Style . Save Styke ..
o Canced Ay aa

Once you have defined your ranges (and, if you wish, the color scale to be used), select
the Save Style command and give the name srtm.qmito the style you have just created
(the .gml extent is automatically assigned, you do not need to type it).

For the other SRTM maps, you can just use the same style by opening the layer's
properties function and select the srtm.qml style from the Load Style tab.

Note! Please pay attention to which layer you are creating the elevation ranges. If you
work on a layer where the elevation ranges from 0 to 3,500 meters and you create the
range classes based on these ranges, all the other times you will upload this style for
other layers, the [0-3,500] meters range will be the one used. This also means that if in
a neighboring layer your elevation range is for example [0-4,000], the elevation range
from 3,500 — 4,000 m will not be visible.

2.4.3 Exercise: how to merge different raster layers into one raster
Sometimes your catchment covers different SRTM raster layers. This is also the case
for our example catchment EDB (which is covered by 4 individual SRTM tiles). Before

we make a selection from these individual raster layers we will need to merge them first
into one raster.
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In this exercise you will learn how to use the Merge tool (this tool provides a similar end
result as the Union tool used during our previous exercise in Section 2.3.1 with vector

layers).

Merging of the 4 raster layers is accomplished via Raster -> Miscellaneous -> Merge.

Weckar

Raster | Click-fu

R [

ﬁ

Sy

> E

select the 4 files to be

GdalTools settings r
About GdalTools

Ras_tgr calcqlgtor o __1 ™ s ’: ‘3
Georeferencer K -4 . |
Inkerpolation v i | | Q Q Q"
RasterCalc K @ s

Terrain analysis 4

Projections K

Canyersian
Exkraction
analvsis

il 20U *

# Build Yirtoal Raster (Catalog)

Merge

B} Information

H' Build overviews (Pyramids)
B Tile index

merged, give the name to the new file SRTM WS EDB

unclipped—-LL.asc, and select Load info canvas when finished. Close the Merge window
when finished and inspect the result. Remove the individual SRTM tiles from your

project.

Y Merge ? X
Input files I{Papuafsrtm_65_14.A5C Seleck...
Qukput file I WS EDE unclipped - LL Seleck..,

Mo data value [D I%]
Layer stack
Use inkersected extent
Grab pseudocolor table From the First image
Creation Options
Iarme Walue | [ Add ]

% Load into canvas when finished

gdal_merge.bat -of GTiff -0

"D fGIS_IndonesiafSRTM{Papua/SRTM WS EDE unclipped -
LL" D:fGIS_IndonesiafSRTMIPapua)srim_64_13.A5C
[}zl _IndonesiafSRTM{Papua/srtm_64_14,ASC

[ /GIS_IndonesiafSRTMPapuafsrtm_65_13,A5C

[ /GIS_IndonesiafSRTMPapuafsrtm_65_14,ASC

©)

Close Help

Note! you will need to carry out the merge on the original SRTM tiles with the WGS84
projection. If you would merge reprojected SRTM tiles it is possible that the edges of
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the individual tiles consists of missing data values which will be included in the merged
raster which is not desirable.

2.4.4 Exercise: determining the resolution of a raster layer

Resolution can be defined as the minimum linear dimension of the smallest unit of a
geographic space for which data are recorded. In a raster environment, these units
have generally a rectangular shape (occasionally systems have used hexagons or
triangles) and they are known as cells or pixels. When a layer has a high resolution, it
means that its cells are of small dimensions. High resolution layers have a higher
degree of detail, and have therefore a larger dimension®.

The resolution of your SRTM raster layer can be found by right clicking on the raster
layer (SRTM WS EDB clipped — LL) and select Properties. Navigate to the Metadata
tab and look for the Pixel Size.

0.0003333353,-0.000533333

What is the linear measure equivalent of this angular cell size?

Answer: to determine what the corresponding cell size in meters of the SRTM elevation
raster is, you need to use the information provided in Section 2.2 on the computation of
angular measurements. The values you visualize in the Pixel size information window
are expressed in degrees.

Computation: 40,075.017 km * 0.00083333 degrees / 360 degrees = 0.0927 km

Another way to find out the resolution of the raster cells in meters is too reproject the
raster file to UTM. This will be done in the next exercise.

2.4.5 Exercise: how to reproject a raster layer

Reprojection is possible within QGIS however it is not able to reprojectArcinfoAscii files.
We therefore first have to convert the ArcinfoAscii (.asc) files into GeoTIFF (.tif). This is
done via Raster — Conversion — Translate (convert format) as shown in the screenshots
below.

® Based on: http://www.geog.ubc.ca/courses/klink/gis.notes/ncgia/u04.html#SEC4.4.1, accessed on
26.01.2012
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Figure 2.5 Conversion of raster formats.

Choose as filetype the [GDAL] GeoTIFF format.

File name: SRTM WS EDE clipped - LL.asc

Files of bvpe:  [iaDAL] All files (%) -

[SDAL] ERDAS IPEGZ000 (*,ip2 *.j2k *, IP2 *,12K)

[GDAL] MraID Generation 4 [ Lidar (*,view * WIEW)

[GDALT Mulki-resalution Seamless Image Database (*.sid *.3510)
GDAL] Virtual Rasker (%, wrt % WRT

[DAL] GenTIFFE i* tif *,Eiff * TIF * TIFF)
[GDAL] Mational Imagery Transmission Farmat (*.nkf * NTF)
[GDAL] Raster Product Farmat TOC Farmat (. koc *, Tiod)
[GDAL] Erdas Imagine Images (*.img *,IMGE)
i L ) ] T

[GDaAL] All Files {*)
[GDAL] ERDAS Compressed Wavelets (¥, ecw * ECW)

dering order

Figure 2.6 ~ Select the correct data format for your raster.

Select the Load into canvas when finished option so the converted file is automatically
shown on the map.
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X

4 Translate (Convert format) ?

Batch made (for processing whole directory)

Input Layer SRTM WS EDE unclipped - LL | ™ Select...

Output File 3/SRTM WS EDE unclipped - LL.tF Select...
Target SRS [ ] [ Select,., ]
Outsize [ 25% }%]
Mo data [ 0 }%]
Expand [ Gray ‘ V]
Srowin [ ]
Prijwin [ ]

Sds

Creation Options

Iarne Valug | [ Add I

Remove

R Load into canvas when finished

gdal_translate -of GTiff "D:/GIS_IndonesiafSRTH/PapuaiSRTM
WS EDB unclipped - LL.asc"

"[3: }G15_Indonesia/SRTM{PapuafSRTH WS EDB unclipped - D
LL.kif"

Figure 2.7 Conversion of raster format from ArcinfoAscii to GeoTIFF.

Select the WGS84 projection when prompted. Remove the SRTM WS EDB unclipped —
LL.asc from the project.

Note! If you have multiple tiles you need to convert you could also opt for the Batch
mode option.

Prior to reprojecting your unclipped SRTM file from WGS84 into the UTM projection you
need to know in which UTM zone your catchment is located. Use Figure 2.3 to
determine this.

Reprojection is done via Raster — Projections — Warp (reproject).

felp  “ector | Raster | Click-fu

Raster calculator .., .
AR E 30X
=N Georeferencer 4 -4 v .
-0 ] Interpolation 4 i ‘ ‘q Q
L RasterCale ’ ﬂ . -

Terrain analysis * I

__!-’ »
B Projections

Canversion L}

“py Assign prajection
Extraction E

{5 Extract projection

Analysis L
Miscellanieous L4

GdalTools sattings
) about GdalTools

Figure 2.8 Reprojection of raster.
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Set the source SRS (WGS 84 or EPSG:4326) and target SRS (UTM 54S or
EPSG:32754). Save the Output file as SRTM WS EDB unclipped — UTM54S, select
Load into canvas when finished and click OK.

X

& Warp (Reproject) ?

Batch mode {for processing whale directory)

Input File SRTM W3 EDE unclipped - LL ™ Select,..

Qutput file %3 EDE unclipped - UTMS45,kF Select...

¥ Source SRS EPSG:4326 Seleck...

R Target SRS EPSG:32754 Select. ..
Resampling method [Near | V]
Mo daka walues [D ]
Mask layer [IDN_admZ | '] Seleck, ..
Memory used for caching [ZDMB '%]

Resize

Use multithreaded warping implementation

% Load into canvas when finished

gdalwarp -s_srs EPS@:4326 -t _sts EPSG: 32754 -of GTiff E]
"Dni/aI5_IndonesiafSRTM/PapualSRTM WS EDE unclipped - LL, GF"
"Di 615 _IndonesialSRTM{Papua/SRTM WS EDB unclipped - UTMS43, kF" D

Figure 2.9  Reprojection of raster from WGS84 to UTM54S using Warp function.

When finished zoom to the layer and inspect if the coordinates in your status bar are
now in meters instead of degrees. What is the resolution of your grid cell?

If you haven’t done so already make sure you also have a reprojected catchment
polygon. Refer to the exercise in Section 2.3.2 on how to do this. Import the reprojected
catchment file into QGIS.

Remove the SRTM WS EDB unclipped — LL.tif and WS EDB — LL.shp from your
project.

2.4.6 Exercise: how to create a sub-selection from a raster layer using a vector file
(clipping)

In this exercise you will make a selection (or clipping) from the merged and
reprojectedSRTM elevation raster layer created in the previous exercise (the SRTM WS
EDB unclipped — UTM.tif) using your reprojectedcatchment boundary vector layer (WS
EDB — UTM54S.shp).

In this exercise you will learn how to use the Clipper tool.
Before we clip we need to determine the extent of the WS EDB — UTM54S vector layer

by right clicking on the layer and choosing Properties. You will find the corner
coordinates under the Metadata tab (Figure 2.10).
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¢ Layer Properties - WS EDB - UTM545

Title

Abstract

General:

Storage type of this layer: ESRI Shapefile

Source for this layer: DUGIS_Indonesia/CatchmentsaSUTMS4SM 00407 versionAVS EDB - UTMS45 shp
eometry type of the features in this layver: Polygon

The number of features in this layver: 1

Fast Access to Features &t ID, Change Geometties
Extents:

Layer Spatial Reference System:
+proj=utm +zone=54 +south +dstum=1"G554 +unitz=m +no_defs

Restore Default Style Save As Default Load Style ..,

W atyle Labels Fields ., General -JEH_‘-' Metadata % Actions U\P Joins

Editing capabilties of thiz layer: Add Festures, Delete Features, Change Attribute Values, Add Aftributes, Creste Spatial Indes:,

In lzyer spatial reterence system units © xMin ybin 13033344 5990445 B4 © xhlax yMax 49957595 9587159.43

| QK ‘ Cancel Apply

Figure 2.10  Layer properties of the WS EDB — UTM54S.shp

Write down (or alternatively copy it to your clipboard) thexMin, yMin, xMax and yMax

coordinates.

Note that these corner coordinate valuescontain a lot of digits. It is to be preferred to
use coordinates without any digits and rounded to the nearest 1000 m. Before we are
going to clip we are therefore going to use other corner coordinates. Make sure that the
extent does not become smaller than the original map. So Xmin_new en Ymin_new
should be less than Xmin and Ymin and Xmax_new and Ymax_new should be greater!

In the example shown in Figure 2.10 the new corner coordinates become:

Xmin = 130333.44 becomes Xmin_new = 131,000
Xmax = 499875.95 becomes Xmax_new = 500,000
Ymin = 8990448.64 becomes Ymin_new = 8,991,000
Ymax = 9587159.43 becomes Ymax_new = 9,588,000

Select the Clipper tool via Raster -> Extraction -> Clipper (Figure 2.11).
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Figure 2.11  Clipping a raster.

In the clipping mode include the new coordinates. Once all of the 4 coordinates are
provided, QGIS will visualize them on the layer map (as shown by the red rectangle
shown in Figure 2.12). This way you can verify if the input you provided is correct.
Double check if you provided the correct coordinate reference values, give the new
layer the name SRTM WS EDB clipped —UTM54S, select to Load into canvas when
finished, and click OK. When prompted for the projection select WGS84. When finished
close the Clipper window.

. Clipper

Input File (raster)
Cukput File
Mo data value
Clipping mode

® Extent

® 131000
1
W E991000

UTMS4S, Eif "

SRTM WS EDE unclipped - UTMS4S | Select...

auafSRTM WS EDE dipped - UTMS45, b

Select...

[

Mask layer

Select the extent by drag on canvas

or change the extent coordinates

* | 500000

v | 9588000

Load into canwvas when finished

gdal_translate -projwin 131000.0 9535000, 0 S00000.0 3221000.0 -of
GTifF "D fGIS_IndonesiafSETMIPapus/SRTM WS EDE unclipped -
UTMS45S Eif " "D fGIS_Indonesia/SRTMIPapuaiSRTM WS EDE clipped -

(6] 4 Close

Help

Figure 2.12  Clipping your raster using a predefined extent which is shown as the red rectangle on the

map.

Remove the SRTM WS EDB unclipped — UTM54S layer from your project.

With this operation you have just created a selection based on catchment boundaries
from the merged and reprojectedSRTM raster layer. By directly using this new layer,
you will be able to speed up computation during your data processing given that the
layers dimension is much smaller than the original 4 layers inputs.
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2.4.7 Exercise: how to convert a vector layer to a raster layer

A zooming on Borneo of the vector layer representing the DSMW is shown below:

Figure 2.13  The DSMW map for Borneo in a vector format

During the preparation of the soil data for our analysis you will have to convert your soll
vector map into a raster map to prepare the input for WFlow. The conversion of a vector
to a raster layer is performed with the Translate function accessible from the Raster
menu -> Conversion -> Rasterize (vector to raster).

Raster | web Help

Raster calculator ... E’ ﬁ 4 ’ _i
Georeferencer 3 :
Interpalation * —
Rast:r based terrain analysis  * < ‘{J ﬂh ﬁ e
)l RasterCalc v I
] Zonal statistics *
Projections
Canyersion . or bo rasker)
B " |9 Polygonize (Raster to vector)
RS ’ *.El Translate (Zonwverk Format)
Miscellaneous G

=5 REE o PCT

= =¥ PCT to RGB
) About GdalTools |

zdalTools settings

.

Figure 2.14  Selection of the Vector to Raster function

Once you made this selection, the following screen will pop-up:
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¢ Rasterize {(¥Vector to raster) 2=l

Input file {shapefile) WS _Digul_IITr - Select. ..
Attribuke Field (]l s
Qutput file For rasterized wectors (raster) Select. ..

B New size (required if output file doens't exist)

L1

wiidth | 3000 = Height | 3000

Load into canwvas when Finished

gdal_rasterize -a DM -ts 3000 3000 -1 WS_Digul_UTM "D:/ICP MERAUKE/Quantitative
companent/Catchment boundaries)Sub-catchments EDE BP WS _DigulWw's_Digul_UTM.shp"

Figure 2.15  Definition of the Rasterize function

For your input file select your vector layer (i.e. DSMW soils Indonesia). To select your
output file, you first have to create an empty raster file (.tif format), and give it a name
(i.e. DSMW soil Indonesia). You can give the new raster map the same name as the
vector layer, because you will be able to distinguish between them by the extension
(.shp or .tif) of the file.

When creating the new raster layer, you always have to select the New size option to
allow QGIS generate the new map. At this point you have to options: either to leave the
default width and height values generated by QGIS, or to define these values based on
your computation of the raster grid cell size (determined by the resolution) that will be
used for the creation of all the input maps for WFlow.

In our example, we will not define the width and length values because we are working
on the Soil map of Indonesia, and not on the SRTM or catchment maps.

The new raster map of the selected layer will appear as follow from the example taken
on the zooming to Borneo (the visualization of the colours depends on the range values
defined in the colour map).

Figure 2.16  The raster visualization of the DMSW for Borneo
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Once you have converted the soil map to a raster format, you will have to re-projected it
based on the UTM projection corresponding to your catchment area. How to perform
this operation has been described in Exercise 2.3.2 of this chapter.
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3 Topographic data

3.1 General description, typology and use

The SRTM data set (Shuttle Radar Topography Missions) provides elevation data at a
global scale and is used to derive stream directions. These stream directions are
subsequently applied at the required resolution of the hydrological model.

An elevation source which is often being referred to and used is SRTM (Shuttle Radar
Topography Mission, 1999). The Shuttle Radar Topography Mission used the SIR-C
and X-SAR radar antennas to collect information in C-band (5.6 cm, 5.3 GHz) and X-
band (3.1 cm, 9.6 GHz) wavelengths. The C-band data were processed at the NASA
Jet Propulsion Laboratory (JPL) and released to the public at a resolution of 1-arc
second (30 m) within the United States and 3 arc seconds (90 m) elsewhere (Hensley
et al., 2000). Absolute vertical accuracy for the C-band DEM was specified as <16 m
globally, with relative accuracies of <6 m in any 225 km x 225 km area (Rabus et al.,
2003). Because of the short wavelength of the SRTM C-band sensor, the height
response over vegetated terrain is influenced by integrated scattering from leaves,
branches, and stems, measuring a phase centre height that is higher than the
underlying bare-Earth surface in vegetated areas.

Note! SRTM is not a true surface elevation model but rather a canopy elevation model.
In steep areas the SRTM describes the surface elevation ok, but for lowland modeling
you can not directly use these data. You need to filter out the vegetation first. The
vertical resolution of SRTM is 1 meter, whereas the vertical error is up to 16 meters, for
detailed flood modeling this is not enough and other sources, such as LiDAR need to be
used instead. For a quick hydrological assessment however, working with SRTM is
sufficient.

3.2 Preparing topographic data as input for WFlow

The SRTM elevation data can be downloaded from the internet, but it is provided on
your USB stick for the whole of Indonesia. The format provided is ArcinfoAscii (.asc)
and the projection is WGS84. For Java the tiles are srtm_58 14 and srtm_59 14
whereas for Papua these are srtm_64 13, srtm_65_ 13, srtm_64_14 and srtm_65_14.
In the exercises of Section 2.4 you have already clipped and reprojected the SRTM
raster layer to your catchment area.

3.2.1 Exercise: how to change the resolution of a raster layer (resampling)

Resampling the different input raster layers to a common resolution is an operation
needed to ensure that the input maps used by PCRaster/WFlow have the same spatial
unit of measure. If input maps are used with different resolutions (cell size), WFlow will
not be able to carry out the computations.

The WFlow model will be prepared to run on a 270 m resolution (3 x 3 SRTM raster

cells). This resolution is chosen for performance reasons. Running the model on a
higher resolution (e.g. 90 m) will require more computation time.
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Prior to resampling you need to determine the extent of your map in meters. Inspect the
Properties of the SRTM WS EDB clipped — UTM54S.tif.

& Layer Properties - SRTM WS EDB clipped - UTM545

e Style r Transparency B colarmap “‘\ General @ Metadata 4 | 3
Title
Abstract

130926,9,.58602e+00 t[

92.3198,-92.3198

+praj=utm +zone=54 +sauth +datum=WG584 +units=m +no_defs

ayer Extent ({laver original source projsction’;

130926,499601 7097725327, 8990990, 720850985497 2363 1
499028,61 15164801 129140, 9588022 9626356763037 080

KD

Restore Default: Skyle Save As Default Load Style . .. Sawve Style ...

‘ oF Cancel Apply Help

Figure 3.1 Properties of the SRTM WS EDB clipped — UTM54S.tif

The width and height of the raster can be determined from the difference between
respectively Xmax and Xmin and Ymax and Ymin.

In the example of Figure 3.1 the width is:

499928.8115164801129140 - 130926.4996017097728327 = 369002.3119147710
meter

and the height:

9588022.9828356783837080 - 8990990.7208509854972363 = 597032.2619846890
meter

Determine the number of 270 meter cells which fit in the x- and y-direction by dividing
the width and height by 270 meter.

369002.3119147710 / 270 = 1366.7 cells
597032.2619846890 / 270 = 2211.2 cells

Since we can not resample to incomplete cells we need to use a complete number of
cells. The number of cells for the resampled 270 m raster therefore become 1367 x
2212 cells.

Resampling is done via Raster — Projections — Warp (Reproject).
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Save the output file as SRTM WS EDB clipped resampled 270 m - UTM54S.tifand
provide the number of 270 m cells which you just calculated. Select Load into canvas
when finished and click OK.

€ Warp (Reproject) ? X

EBiakch mode {for processing whole directory)

Input file SRTM WS EDE clipped - UTMS45 = Select...
Cukput file lipped resampled 270 m - UTMS45, L Select...
Source SRS [ ] [ Select... I
Target SRS ( | [ elect...
Resampling method [Near | Vl
Mo data values [El l
Mask layer [IDN_admZ | '] Select...
Memory used For caching [ZDMB '%]
% Resize
width | 1367 = Height | 2212 =

Use multithreaded warping implementation

R Load into canvas when finished

gdalwarp -ts 1367 2212 -of GTiff "0 fGIS_IndonesiafSRTM{PapuafSRTM WS EDE
clipped - UTMS45.tif" "D:/GIS_IndonesiafSRTM{Papua/SRTM WS EDE clipped
resampled 270 m - UTMS45, 6"

Figure 3.2 Resampling a raster file using the Warp function.

Close the Warp (Reproject) window and inspect your resampled SRTM map. Delete the
SRTM WS EDB clipped — UTM54S.tif from your project.

3.2.2 Exercise: convert your resampled map to ArcinfoAscii format

Now that you have resampled your SRTM map you need to convert it to the
ArcInfoAscii format via the Raster — Conversion — Translate menu ( Figure
2.5).

Choose the ArcInfoAscii format (cf.  Figure 2.6) and choose -9999 as the No data

value (default this is 0).Select Load into canvas when finished and click OK (Figure
3.3).
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% Translate (Convert format) ? X
Batch mode (For processing whole directary)
Input Layer SRTM WS EDE clipped resampled 270 m - UTMS45 | Seleck..,
Qutput file 'SRTM W'S EDE clipped resampled 270 m - UTMS435, asc Select...
Target SRS [ ] Select,,,
Outsize [25% =
X Mo data -9999 =
Expand [Gray V]
Srowin [ ]
Priwin [ ]
Sds
Creation Options
Mame Valug ‘ [ Add ]
X Load into canvas when finished
gdal_translate -a_nodata -9999 -of AAlGrid "D fa15_Indonesia/SRTH/PapualSRTM E]
‘W3 EDE clipped resampled 270 m - LTMS45 "
"D:,l’GIS_Ind?nEsia,l’SRTM;’Papua,l’SRTM 'S EDE clipped resampled 270 m - D
UTM545, asc
Close Help
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Figure 3.3 Convert the resampled 270 m SRTM raster from GeoTIFF to ArcinfoAscii format.

You will get a warning: Warning 1: Producing a Golden Surfer style file with DX and DY
instead

of CELLSIZE since the input pixels are non-square. Use the FORCE_CELLSIZE=TRUE
creation option to force use of DX even though this will be distorted. Most ASCII Grid
readers (ArcGIS included) do not support the DX and DY parameters.

This warning has to do with the irregular cell size of the grid cells. When you inspect the
header of the ArcinfoAscii file you just created in a text editor (Figure 3.4) you will see
that the dx and dy are indeed not the same.

hool=s 1367

nrovs 2212

®llcorner 130926 . 499601709770

v1llcorner 8990990 . 720850985500

d= 269.935853631873

dy 269 .905085888197

HODATA walus —-9999
1389 1405 1479 1583 1601 1581 1678 1734 1724 1744
1441 1412 1442 1489 1509 1568 1633 1674 1625 1671
1472 1523 1449 1437 1450 1509 1561 1le06 1575 1648
1512 1597 1540 1524 1466 1479 1503 1540 1585 1595
1590 1678 1623 1595 1572 1524 1527 1516 1525 1555

Figure 3.4 Header of the SRTM WS EDB clipped resampled 270 m— UTM54S.asc
3.2.3 Exercise: change the cell size of your ArcinfoAscii grid

Since WFlow expects a regular cell size we need to manipulate the resampled
ArcInfoAscii grid a little bit. Change the dx and dy values (Figure 3.4) to 270 m and also
round the xlicorner and yllcorner coordinates to the nearest meter. Save the file as
SRTM WS EDB clipped resampled 270 m adjusted — UTM54S.asc. The resulting
ArclInfoAscii file should look as follows:
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ncols 1367
nrows 2212

®llcorner 130926

v1llcorner 2990991

d= 270

dw 270

HODATA walus -—-9999
1389 1405 1479 1583 1601 1581 1678
1441 1412 1442 1489 1509 1588 1633
1472 1523 1449 1437 1450 1509 1561
1512 1597 1540 1524 1466 1479 1503

ArFAaa 4, \An A sAana ArmaE  ArAaa A rSad Aran

Figure 3.5 Adjusted header of theSRTM WS EDB clipped resampled 270 m adjusted — UTM54S.asc

Remove the SRTM WS EDB clipped resampled 270 m— UTM54S.asc from your project.
3.2.4 Exercise: convert the ArcinfoAscii grid to PCRaster format

Import the SRTM WS EDB clipped resampled 270 m adjusted — UTM54S.asc. Select
the proper projection when prompted (UTM54S in the case of EDB). Convert the

ArcInfoAscii grid with the adjusted header (Figure 3.5) to PCRaster format, similarly to
the exercise of Section 3.2.2.
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4 Land use and land cover data

4.1 General description, typology and use

Information on land use and land cover (LULC) is required in hydrological modeling to
define the patterns of water interception by canopy cover, and the patterns of water
infiltration and surface flow according to soil saturation rates and land cover type.
Currently, LULC information is available through satellite images at different resolutions,
and often field measurements are used to validate satellite data. Land use is classified
according to the vegetative cover (i.e. forest, desert, ice cap, water bodies, grassland or
cultivated land). Depending on the detail of the images, these categories are further
classified in sub-categories according to their specific vegetation type (i.e. evergreen
forest, broad leaves forest, deciduous forest).

Acquisition of information to detect land cover and land use type is often carried out
making use of remote sensing Landsat data. Since the 1970’s, Landsat data have been
rendered available through the Landsat Program (http://landsat.gsfc.nasa.gov/) which
embraces a number of Earth-observing satellite missions jointly managed by the
National Aeronautic and Space Administration (NASA) and the United States of
America. Throughout its history, there have been 7 Landsat satellite projects, the latest
being the Landsat 7, sent on orbit in 1999. At present, all Landsat Earth-observation
data are freely available to the public through the USGS since January 2009.

Nowadays there exist several online sources of land use data. Some of these sources
are:

* NASA LCLUC - Land Cover and Land Use Change Program: which contains
information on, for example, land cover conversion, land use intensification, and land
degradation in arid and semi-arid environments (Knivila M. 2004);

=  FAO Global Land Cover Network (http://www.glcn.org/index_en.jsp);

FAO FAOSTAT for agricultural land cover types;

FAO FORIS for forest cover and inland water data at the country level;

GlobCover, from the European spatial Agency (ESA)

NationalUniversity of Singapore (CRISP)

The underlying assumption of processing land use data in this workshop is that current
land cover types have not significantly changed over time since the period of their
measurement (2009). This assumption results from the simplification required by the
limited time availability to carry out an in-depth land cover research and analysis for short
time steps (i.e. year). In an in-depth analysis, and supposing that relevant data are
available, variation in land cover should be accounted for during the computation of the
discharge series.

For its completeness in terms of data availability, and for its satisfactory degree of
spatial resolution, the European Space Agency (ESA) GlobCover data will be used in
this workshop. GlobCover data have been collected by the Envisat environmental
satellite, with the aim to produce a global land cover map to a resolution three times
sharper than any previous satellite map®. In the 2.3.2009 version, the provided

¢ Source: http://www.esa.int/esaEO/SEMGSY2IU7E index_0.html accessed on 31.01.2012
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resolution for land cover images is of 300 meters. Data are available in a raster format
and provide full coverage for all of Indonesia.

The Centre for Remote Imaging, Sensing and Processing (CRISP) of the National
University of Singapore also provide a good alternative LULC data source to
GlobCover. Unfortunately though, satellite images from this dataset are not available for
the Eastern provinces of Indonesia, and therefore they do not guarantee complete
national coverage for our analysis. Yet, for data retrieval from provinces where
observations are available, CRISP data for the years 2000, 2007 and 2010 are provided
on the USB stick of this workshop including some publications on them.

Table 4.1 Sources of land cover data for Indonesia.

Source ESAloniaGlobCover CRISP

Webpage | http://ionial.esrin.esa.int/ http://www.eorc.jaxa.ip/SAFE/LC MAP/

Format Raster file (GeoTIFF) GeoTIFF

Resolution | 300 m 250 m

Version 2.3 2009 (V2.3) 2000, 2007, 2010

Comment | Available for all of Indonesia| Black strip over PapuaProvince due tg
missing satellite image

42  GlobCover (ESA).

As for the majority of remote sensing data interpretation, the principle behind the
production of land cover maps (such as GlobCover) is the classification of land cover
type based on the reflectance of the Earth surface to solar radiation. Land cover and
land use types are classified based on the different types of solar ray interaction with
Earth features that can occur, namely transmission, absorption, reflection, scattering
and emittance. Moreover, before final mapping, a correction of the image interpretation
is performed, by taking into account disturbance factors such as for example cloud and
haze cover.

The most updated ESAGlobCover data refer to the observation period of January-
December 2009. 2009 data have been generated from MERIS (Medium Resolution
Imaging Spectrometer Instrument) and the final product is delivered with a spatial
resolution of 300 meters.

For additional information on the characteristics of the dataset, the reader is referred to
the validation report (Bontemps et al., 2011) included on the USB stick.

GlobCover provides two main sources of data: version 2.2 and version 2.3. Version 2.2
contains a global and regional dataset. The regional dataset contains more
classification categories to reflect the regional character of land cover types. The global
dataset contains more general categories which allow for world-wide usage.

The global 2.3 version of GlobCover has 22 land cover classes defined in accordance
with the UN Land Cover Classification System (LCCS) (Bontemps S. et al., 2011).
These classes are listed in Table 4.2 below. Since the number of these categories

" The information contained in this section has been taken from Bontemps S. et al., 2001. GlobCover
2009.Product Description and Validation Report.UC Louvain and ESA Team
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already provides the degree of detail for LULC classification, for the scope of our
analysis we will use this dataset in our analysis.

Table 4.2 GlobCover global v2.3 version with 22 land classification categories (from Bontemps et al.
2011)
Value | GlobCaover glabal legend
11 Post-flooding or irrigated croplands
14 Rainfed croplands
20 Mobosaic Cropland (50-70%) / Vegetation (grassland, shrubland, forest) (20-50%)
30 Mosaic Vegetation (grassland, shrubland, forest) (50-70%) / Cropland (20-50%)
40 Closed to open (>15%) broadleaved evergreen and/or semi-deciduous forest (>5m)
50 Closed (>40%) broadleaved deciduous forest (=5m)
60 Open (15-40%) broadleaved deciduous forest (>5m)
70 Closed (>40%) needleleaved evergreen forest (>>5m)
90 Open (15-40%) needleleaved deciduous or evergreen forest (>5m)

100 Closed to open (>>15%) mixed broadleaved and needleleaved forest (=5m)
110 Mosaic Forest/Shrubland (50-70%) / Grassland (20-50%)

120 Mosaic Grassland (50-70%) / Forest/Shrubland (20-50%)

130 Closed to open (>15%) shrubland (<5m)

140 Closed to open (>15%) grassland

150 Sparse (>15%) vegetation (woody vegetation, shrubs, grassland)

160 Closed (>=40%) broadleaved forest regularly flooded - Fresh water

170 Closed (>40%) broadleaved semu-deciduous and/or evergreen forest regularly
flooded - Saline water

180 Closed to open (>15%) vegetation (grassland, shrubland, woody vegetation) on
regularly flooded or waterlogged soil - Fresh, brackish or saline water

190 Artificial surfaces and associated areas (urban areas >50%)

200 Bare areas
210 Water bodies
220 Permanent snow and 1ce

A screenshot of the GlobCover map for Indonesia is shown below:
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4.3 Preparing land use and land cover data as input for WFlow

GlobCover data can be downloaded from http://ionial.esrin.esa.int/. The file to be
downloaded is the zip file Globcover2009 V2.3 Global .zip. For simplicity, this file has
been included on the USB stick. Unzip the file and read the Read Me pdf file.

Open your river basin project in QGIS. Identify the format of the land cover map and
import the file using the correct selection tool in the menu toolbar. If you are unable to
visualize the available files in the GlobCover folder, select from the Files of type bar the
All files(*) option as shown below.

Open a GDAL Supported Raster Data Source B s

Look it | ) Globeover2009 V2 3_Global_ x| «®EcFE-
4l Globeover2009_Legend, s * ELOBCOVER_L4_2004C
1] Globover2009_Praview,ipg = GLOBCOVER L4_2008C
- GlobCover2009_ReadMe pdf = GobCover_Legend.dsr
= globeaver_dlip. thw o GlobCaver_Lsgend byr
=] globeover_dip.bF

= | globeover_cp. bF sux. el

gluj-:-hcwm_dp_hﬁm'r

_-ﬁl;icubtuvuf_n:ﬁp.ﬁf.vd.ﬂbf

= globeover_dip.tif vat b, WLO0B2S, 3756.4056. 5 lock

*| globcover_dip_tiF el

| GLOBCOVER L4 200801 _200912_V2.3.0f

| GLOBCOVER_L4_200901_200912_V2.3,tF . auxx,
| GLOBCOVER _L4_200901_200912_V2.3.tf .ovr

= GLOBCOVER _L4_200901_200912_V2,3.bF vk, dbf
| GLOBCOVER _L4_Z00901_Z00912_¥2.3_CLA_OLGF

4 |

To learn on how to perform location specific selections in a raster environment, and to
reduce the computation time and the size of our project, we will now create a selection of
the GlobCover map for Indonesia first, and for each of our catchments thereafter. The
process on how to make a selection from a raster layer has already been explained in
Section 2.4.6, refer to this section for the instruction on how to perform the selection

108

Please note that when you import the GlobCover layer on your QGIS project, the colour
map will not be automatically uploaded as it appears from the previous snapshot. If you
want to visualize a coloured map of the land cover map to see what the distribution of
land cover types in Indonesia is, you need to change the colour settings from the layer’s
properties. Based on the legend coloured classes in Table 4.2 and by accessing the
layer’s properties tab from the layer's menu, change the GlobCover map or Indonesia
from the layer’s Properties -> Style -> Colour Map.
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Table 4.2 shows that the GlobCover version 2.3 global land cover types are classified in
22 land categories. These classes already give quite some information on the type of
land cover existing in our catchment.

In WFlow the user can freely define the number of categories (s)he wants to include in
the reclassification table. Since WFlow requires to define a soil depth for each land use
type used, the greater the number of categories, the greater the amount of information
required. For matters of simplicity, in our analysis we will reclassify the existing 22
categories into 6 general classes as listed in Table 4.3below.

Table 4.3 Selected land cover categories for WFlow.
Class number| Category
1 Irrigated Agriculture
2 Rainfed Agriculture
3 Forest
4 Grassland/Shrubland
5 Open Water
6 Paved/bare areas

4.3.1 Exercise: prepare a land cover reclassification table

In Excel, create a reclassification table listing in which the 22 global land cover
categories fit in our 6 land cover classes defined for WFlow.

4.3.2 Exercise: associate land cover class with soil depth

Once your reclassification table is ready the land cover classes need to be associated
with soil depth since this is a required input parameter for WFlow. For this we will use
rooting depth as this is intrinsically related to soil depth (the soil is at least as deep as
its rooting depth). The International Satellite Land-Surface Climatology Project, Initiative
Il (ISLSCP 1) of NASA
(http://daac.ornl.qov/ISLSCP_Ill/guides/ecosystem_roots _1deg.html) provides
information at a 1 degree (approx. 100 km) resolution concerning the relation between
rooting depth and above ground land cover types. We will use these rooting depth data
to estimate our soil depth for the 6 land cover categories selected for WFlow.

@L
§ g

' A q Dismbuted Active Archive Center for @
ical Dynamics
_‘

[+*]Home ISLSCP Il ECOSYSTEM ROOTING DEPTHS

Page |1 ¥ Reconls per’ que 10 =
Granule Name & I Metadata Preview Im: \ge
Projection: WGS 84 Ww’
= Mean 50% ecosystem rooting depth in Spatial Extent: N: 90, S: -90, E: 180, W:-180
meters Start DateTime: 2005-02-01700:00

End DateTime: 2005-07-31723:59
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The ISLSCP rooting depth layers are in an ESRI ASCII GRID format. The dataset
contains 3 files, namely?®:

1. 50ecosys_rootdepth_1d.asc [wcs50]: Mean 50% ecosystem rooting depth in
meters. This is an estimation of the rooting depth that contains 50% of all roots. "1d"
implies a 1-degree spatial resolution (lat/long) — file name wcs50;

2. 95ecosys_rootdepth_1d.asc [wcs95]: Mean 95% ecosystem rooting depth in
meters. This is an estimation of the rooting depth that contains 95% of all roots. "1d"
implies a 1-degree spatial resolution (lat/long) — file name wcs95;

3. ecosys_rootdepth_1d.dif : A table of the values in 1) and 2) that have been
replaced and/or modified so that the original files match the land/water mask used in
this data collection. This file can be used with 1) and 2) to reproduce the original data
collected by the investigators.

Since we are interested in detecting the maximum soil depth, which of the above files
should we use?

Once you access the data, you are prompt to a selection window where you can
customize your data selection from the global dataset. The screen will appear as
follows:

= Daata Units: meters
= Scale Factor: 1 -

Data Customization and Download

Coverage: hMean 50% ecosystem rooting depth in meters Set This Map I

-121.50000, 17 50000

Use | I/ to selecta region as the spatial extentto subset data I Enhance Image Display [+] Show Legend

Opacity:Y 1
Projection: [wicssa =1 OGC WCS Requests:
Spatial Extent *: [+] Show GetCapabilities
Resolution {x. y}: [1 £ degrees a0 [+] Show DescribeCoverade
Format: [ GeoTIFF (FLOATZZ) =1 [Freo «f:j,-h =0
- OGC WMS Requests:
Time: IAII vl I—QD [+] Show GetCapabilities
[+] Getap Request
Bands: |AII 'I Foom To I
* Eastand Morth bounds are adjusted
Interpolation [Mearest Meighbor =] automatically to rmake widthiheight to be

Method: integer multiple of resolution iy

Download Data | Reset |

By using the zooming and legend options provided in the screen, you can make an
extent selection for Indonesia, and you can visualize the (20) soil depth categories from
the legend. After the selection, the screen will appear as follows:

8 Source: http://daac.ornl.qov/ISLSCP_ll/quides/ecosystem roots 1deg.html accessed on 31.01.2012
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Data Customization and Download

Coverage: Mean 50% ecosystem rooting depth in meters

Spatial Extent *:

et This Map

[+] Show Legend

o)

(=]

sio
1000 m
= .
" ETR—

Use |I I to selecta region as the spatial extent to subset data ™ Enhance Image Display
Selzct Region function astivated Opacity:?
Projection: CEEED =171 DGCWCS R

Legend of Map

Data Unit: meters

Data Unit: neters

EE 5.1 - £.138358311

B o.158358511 - 6.1528

N 9.1528 - ©.16284457

B §,16284457 - 8.1764

W p.1704 - ©8.176210236

% 8,176218236 - @,180653332

9 9.180653332 - B.18394665

9 8.18394665 - B.186222039

9 a.186222630 - 6.1879558894

S 9,187558894 - 0.188

= p.188 - B,18956392

y 9 8.18936392 - B.19438568
6,19438368 - B,202378969
0.2023768969 — 0.214047277
8.214847277 - 8.229888074
6.220808874 — 8.2584

[ @.2504 - ©.277187433

= p,577187433 - 6.3128

W o.3128 - 6.364882353

B o, 354002355 - 6,5
Other

N

|

[+] Show GetC:

[e1zs

Resolution (x. y): |1 1 dearees

+] Bhow DescribeCoverade

[+] GetCoverane Request

Format: [GeoTIFF (FLOAT3Z) =l [ez125 —I:(»h 51125
Time: All ¥ 11575
Bands: 18 Zoom To

~ East and Morth bounds are adjusted
automatically to make widthiheight to be
integer multiple of resolution sy

Download Data | Reset |

Interpolation
Method:

Mearast Meighbor

O0GC WMS Requests:
+] Show GetCapabilities
+] Getviap Request

Once you have defined your selection parameters, you have to click on the Download
Data button. We have saved all the required downloaded files in the Land Cover folder
on your USB. Access the directory and import in QGIS the right wcs file. After the

import, you will visualize the layer as follows:
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This is because the rooting depth categories have not been categorized based on the
depth ranges. The legend map for the land cover-rooting depth map is the following:
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Legend of Map

¥ X

Drata Unit: meters

Data Unit: neters

Hl 9.1 - 8.536196662

Bl g,586196682 — 0,772

N g,772 - B8,.899839984

I g,399839984 - 0.996
8,996 - 1,.069945452
1.069948452 - 1,126496956
1.126496956 - 1.168411906
1.168411906 - 1,197371485
1.1973714085 - 1,21438593
1.21438593 — 1.22
1,22 - 1,236942463
1.236942463 - 1.288289865
1.288289868 — 1.375685499
1.375685499 - 1,50217883
1.508217883 - 1.672834135
1.672834135 - 1.896
1.896 — 2.186197191

B 2,186197191 — 2,572

Bl 2 572 - 3,126692157

N 3126692157 - 4.6
other —

A closer look at the map tells you what the variation in rooting depth is. Within the
provided range (0.1 to 4.6 meters) create 5 categories of rooting depth from the
properties layer and visualize the results on the screen. Based on the ranges you have
defined, you should be able to get an overview similar to that of Figure 4.1 below
(please note, the legend above does not correspond to the color map in Figure
4. 1below). Zoom to your catchment area and determine what the variation in rooting
depth is.

Figure 4.1 Overview of rooting depth based on Land Cover (blue 0.8m, purple 1.5m, red 3.5 m).

You will soon realize that the detail of information available from the ISLSCP II
database is actually too coarse to prepare a relation table between the land cover type
and the soil depth. Why is that?

An important check that was not performed when we referred to the ISLSCP database
was to have a look at the spatial resolution of the database. The raster size of the
ISLSCP Il dataset is 1 * 1 degrees. Following the computation procedure explained in
Section 2.2, you can easily calculate the spatial metrical grid dimension of the dataset.
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4.3.3 Exercise: estimate soil depth for land cover categories based on rooting
depth

With this exercise you will estimate the rooting depth associated with each land cover
type based on the information provided by the rooting depth map, and based on your
groups best judgments.

Tip: look at the maximum rooting depth information provided by FAO for different crops
and fruit plants at:
http://www.fao.org/docrep/X0490E/x0490e0e.htm#chapter%208%20%20%20etc%20un
der%20s0il%20water%20stress%20conditions. This information will guide you in the
creation of the ranges for the 6 selected categories.

The SMAX Word version file, contained in the following directory: Soil data -> FAO Soil
Moisture Content -> FAO Soil Moisture gives indications about the maximum rooting
soil depth that can be expected for agricultural land. Refer also to this source to make
your estimates.

The last step is the preparation of the text file containing the land cover type and the
associated soil depth. Name the file Land Cover Soil depth.txt and give a brief
description of the data contained in the file to facilitate other users in reading its content.
An overview of the file is given below.

[P Land Cover soil depth.txt - Notepad 10l x|
File Edit Format Wiew Help

FThis file containes the soil depth associate with the Tand cover types used in WFlow. ;l
*First column is land category, second column is soil depth (in meters)

*prepared by Agnese Boccalon, 14.02.2012

*_iteko, Indonesia

11 a00

14 G000

20 a00

30 1400

40 1900

50 1900

[=10] 1500

70 1900

Eld] 1900

100 1500

110 1900

120 1400

120 1400

140 1400

150 1400

160 1500

170 1900

150 1400

1o0 <]

200 =]

210 4]

220 4]

K1l H

This is the last step of the preparation of your land cover data as input for WFlow.
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5 Soil data

5.1 General description, typology and use

Soils have important production and conservation functions via their capacity to store
nutrients, and for their hydrological property of transporting and retaining water. For
hydrological analysis, information about soil types helps define in more detail the
patterns of subsurface and overland flow in saturated and unsaturated layers.

Different types of soils have different depth and varying storage capacity. Soil water
storage capacity depends on soil depth and porosity. Porosity is defined as the extent of
space in between soil particles that is not filled with solid matter. Void space can either
be filled with air or water. The higher the density of particles in the soil, the lower the
porosity, and the lower the volume of water that can fill the air gaps between the
particles. Figure 5.1 shows an example of different porosity types in soils.

"'7 7
’?{C ’\/} \ \;)Cf ‘1
r*m{‘; DA
Gavm Gra\ol Sand Clay

well sorted, high porosity poorly sorted, low porosity

7 3

G2 )

CPI‘DPHIPG Sandstone Clay
low porosity high porosity
L;hes’.one Shale
low porosity low porosity

Figure 5.1 Porosity for different soil types.

Source:http://www.amiadini.com/NewsletterArchive

Information on soil water retention properties and nutrients composition is also valuable
to determine the potential productivity of land. Yet, when coupled with information on,
for example, topography and land cover, the analysis of soil characteristics can equally
identify factors such as risk of land degradation and exposure to soil erosion.

Knowledge about the soil composition and their location is therefore a valuable input for
both hydrological modeling and for studies related to the estimation of land productivity
for agricultural production and food security investigation.

Digital maps on soil type, soil properties and soil degradation rates are available from
several international and national research institutes that work with land resources.
Information is available at different scales and resolutions, and are either area specific
(i.e. soil map at regional level) or have a worldwide coverage.
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The Land and Water Division of the Food and Agriculture Organization of the United
Nations (FAO) in collaboration with UNESCO has developed a digital world map of soils
known as the Digital Soil Map of the World (DSMW). The latest updated version is
Version 3.6, which was completed in January 2003, and further revised in February
2007. This digital soil map is available in a vector format.

A more recent and refined source of information on soils mapping at the global scale is
the FAO-IIASA (International Institute for Applied System Analysis) Harmonized World
Soil Database (HWSD). The database was released in March 2009 and it uses the
information provided by the DSMW and integrates them with updated national and
regional soil information collected from national institutes. This new database resulted
from the recognized need to update the global agro-ecological zones study of FAO, and
provides a more detailed information base for soil-related studies at a regional scale.

This new FAO-IIASA database was achieved in partnership with ISRIC (World Soll
Information independent knowledge centre), the European Soil Bureau Network (ESBN)
and the Institute of Soil Science of the ChineseAcademy of Science. The HWSD soil
dataset is available in a raster environment. A so-called HWSD Viewer available when
downloading the HWSD datasets provides a link between the raster database and a
shape file describing soil type categories, occurrence and physical characteristics.

For the simplicity in handling soil vector data as compared to the HWSD raster data,
this workshop will make use of the DSMW datasets for the data preparation process for
the hydrological analysis with WFlow. However, for those users who are more familiar
with GIS applications and data management from raster layers, the use of the HWSD
dataset can also be considered for future soil-related GIS analysis.

Some explanation about the nomenclature
To be able to read the information contained in the FAO Digital Soil Map of the World, it
is useful to recall the meaning of the following terms:

FAOSOIL or Soil Mapping Unit (SMU) symbol: Af14-3c
SNUM or Soil Mapping Unit (SMU) number: 1
DOMSOI or Dominant Soil Unit: Af
Soil class: A

Ferric Acrisols
Acrisols

An example of how you can find this information when using the DSMW soil layer is
provided below:

{} Attribute table - DSMW JRN vector =2 0 / 17 Feature(s) selected

SMUM FAOSOIL DoMS0T
0 4545 | Mes0-3b Me MULL

1 4573 | TmZ3-2c Tm MLILL
2 4518 | J=62-2)3a Je MULL

PHASE]

In the DSWM file, the SMU number is found also with the nomenclature SNUM. As
shown in the example above, a SNUM code is a reference numerical code associated to
each FAOSOIL type. In the above example, SNUM 4545 corresponds to the FAOSOIL
type Ne60-3b.
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In general terms the components of a FAOSOIL type are explained as follows:

/53 213

M)
dominant =oil texture clazs

zoil componert slope clazs of dominant soil

The DSMW file SoilDatahelps reading the above nomenclature.
In Table 5.1 below the correspondence between the code used in the SMU symbol and
the related value of the texture and slope class is given.

Table 5.1 Slope code specification for each texture class.
Texture Meaning Slope code Meaning Corresponding value
class (% slope)
1 Coarse a Flat 0-8
2 Medium b Undulating 8-30
3 Fine C Hilly > 30

5.2 Digital Soil Map of the World (FAO)

Source FAO Harmonized World Soil Database | FAO Digital Soil Map of the World

(HWSD) (DSMW)
Webpage | http://www.fao.org/nr/land/soils/harmoni | http://www.fao.org/geonetwork/srv/en/
zed-world-soil-database/en/ metadata.show?id=14116

http://www.iiasa.ac.at/Research/LUC/Ex{
ernal-World-soil-
database/HTML/index.html

Format Raster file (.bil) linked to attribute Vector data (ESRI shapefile, Erdas
database in Microsoft Access format format, IDRISI format)

Scale not applicable 1:5.000.000

Resolution | 1 km (30 arc seconds by 30 arc not applicable
seconds)

Projection | (longitude, latitude) latitude — longitude

Version 1.1 (March 2009) 3.6 (Feb 2007)

Details Improved reliability of data for SE Asia | Available for all of Indonesia

The FAO Digital Soil Map of the World (DSMW) dataset contains nearly 7,000 soil
mapping units (SMU). All these units are classified according to their dominant soil types,
texture, occurrence and major physical and chemical parameters.

When you download the FAO DSMW dataset and unzip the downloaded file, you will find
the following files inside the directory:

1.the DSMW shape file containing the vector layer with the digitized soil map for the
entire world;
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2.the SoilData file, giving a general overview of the content of the other files in the
directory, and describes the meaning of the codes used for the description of FAO Soil
types (i.e. content of nomenclature example above);

3.the SU_Info Excel file describing, for each type of soil, selected chemical and physical
parameters;

4.the WORLD764 Excel file, containing information on the Soil Mapping Unit
Composition (i.e. percentages of dominant soil);

5.the Generalized_SU_Infofile containing information on how data on soil units have
been collected and processed;

6.the BasicFilesSc file, describing soil mapping units dominant textures and occurrence
based on topography;

the DSMW dbf file, functioning as the attribute table for the soil vector layer.

Digital Soil Map of the World

e
- ,‘_f“- o : (_._,Ar
. R
> z' —s.’*

s
A

"

Figure 5.2 Overview of the FAO Digital Soil Map of the World, with a zoom to Indonesia.

To get a better overview of the type of data you are working with and the amount of
information that this dataset contains, please have a look at the above mentioned files.

5.3 Preparing soil data as input for WFlow

In WFlow, the soil is represented using a simple bucket model (comparable to the
TOPOG SBM model) that assumes an exponential decay of the soil hydraulic
conductivity (Ksat) with depth. Lateral subsurface flow is modeled using the Darcy
equation. Soil depth is specified for different land-use type and subsequently scaled
using the Topographic Wetness Index.

WFlow computation of evapotranspiration is also based on soil water depth. We need
therefore to prepare, for each identified soil type, a table containing information on soil
physical parameters and soil depth. This is simply done by relating the identified soil
types for Indonesia to the parameters table defined through exercises described in the
next Sections.

The exercises described in the following sections will guide you through:

» the reclassification of soil types based on soil categories existing in Indonesia;
= the definition of the soil physical parameters required as input for WFlow;

= the preparation of the input map raster file for WFlow from the soil vector layer.

At a later stage, you will also:
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] clip the DSMW of Indonesia to your catchment;
] relate the existing soil types in your catchment with the soil reclassification table
previously prepared,;

For specific use for WFlow, the two outputs you will have generated at the end of this
exercise are:

a. the DSMW rasterized clip for your catchment;

b. the text format file containing the reclassification table and the soil parameters.

5.3.1 Exercise: preparing the soil reclassification table

In the exercise described in Section 2.3.1 you already created a clip of the DSMW on
Indonesia and PNG (layer DSMW Indonesia+PNG — LL).

You are now going to reclassify the existing soil types within Indonesia. It is important to
mention that the reclassification can also be done with the QGIS GRASS tool, but we
will not discuss the use of this tool here. The reclassification process we will describe, is
made of different steps. You can choose your own way to reclassify the soils. However,
the way suggested in this manual comprises the following steps:

a. open the attribute table of the DSMW Indonesia+PNG — LL layer, and click on the
header of the attribute name DOMSOI first, and on that of FAOSOI later. You will see
that QGIS will automatically sort the data based on your selected attributes (DOMSOI
and FAOSOI);

b.  make a selection of all the attributes in the table by making use of the menu tools
at the bottom of the table (Select All command). Once all the attributes are selected,
choose the Copy selected rows to clipboard tool. This operation allows you to paste your
selection in an empty Excel file. Alternatively, you can also directly import the .dbf file
(database file) into Excel.

(U Metrtute Labde - DAMW Indonessa = 1106 * | vt maww(s) selectnd = 3 = -l:t.'."
Q|

—) —J _J SO S

DEEORDEECEE -1

Show selected only ICopy selected rows to clipboard (CtrI+C)kive

You are now ready to prepare the soil reclassification using Excel.

C. Open Excel and paste the copied contents of the attribute table to an empty Excel
sheet. Produce a table containing only the SNUM, FAOSOI and DOMSOI attributes, and
delete all the other attribute columns in the sheet that are not relevant for our
reclassification. Sort the selected data in the following order: DOMSOI, FAOSOI, SNUM;
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The DOMSOI column classifies the soils based on their dominant soil type. The Nd
DOMSOI nomenclature for example corresponds to the DistricNitosols dominant soil
category.

As previously explained, in the dominant soil type, the first (capital) letter of each
DOMSOI identifies the soil class to which the dominant soil belongs. In our example, N
corresponds to the soil category of Nitosols.

The correspondence between the dominant soil type and its soil class is provided by
FAO and it can easily be visualized in the DSMW legend of the map. The following
screenshot provides an overview of the soil classes and their dominant soil types. A copy
of the Legend is provided on your USB stick in the Soil data sub-directory.

Create a classification of the DOMSOI existing in Indonesia, and associate each unique
DOMSOI with the corresponding SNUM codes.

Legend
A -ACRISOLS
Af-Farric Acrsols

i REGOSOLS Wm= Mallie Planesols

fic- Calcaric Regosols

W O- PODZOLUVISOLS -
™ [id - Dystric Podzoluvisols W

Hh- Haplic Phasozems W Mg Gleyic Greyzems

M Mo- Orthic Greyvzems Ws- Soladic Planasols
W N- NITOSOLS
W Nd- Detre Nitoaals - Eutrie Regoasls
B Ne- Eutric Nitosoks Rx- Gelic Regosals
B K- Humic Nibsols 8 5. SOLONETZ

- HISTOS0LS Sg- Glayic Solonatz

Hl- Luvic Phasozems
[- Lithosals

1- FLUVISCLS

Je- Calcarlc Fluvissls
I+ Dystric Fluvtsols
1n - Eutric Fluvisols

Wa- Galic Plangsoli
- XEROSOLS
xh- Haplic Xerosals

W [e- Eutric Podzoluvisols
B [o- Gleyie Podzaluvisol:
W F-FERRALSOLS

W Fa heric Ferrlsols

W Fh-Humic Ferralsals

Ag-Gleyic Atrsols Ad- Dystric Regosals
Ah-Hurnic Acrsols
Bag- Orthic Acrisols
Ap-Flinthis Acrisals
B- CAMBISOLS

Xke Calcic herosols
X- Luyie Xgrosols

Be- Chromic Cambrsols 8 Fo-Qriic Ferralsals It Thianic Fuvissts m Od- Dystric Histosols ™ Sm- Mallic Solonatz Xy Gypsic Xerasals
B~ Dystric Cambisels M Fp - Plinthic Ferrasols W §- KASTAZNGZEMS B Op- Eutric Histosols W Sg- Orthic Solonetz ¥-YERMOSOLE
Ba- Eutric Cambigals W Fr-Rhodic Ferralssts B iR Heplic Kestanopems @R Oy- Galic Histosok W T-ANDOSOLE ¥h- Heglic Yermosals
Bi- Ferralic Cambisals B Fy- Xanthic Ferralsels B Kk- Caleic Kagtanozems P- PODZOLS B Th- Humic Andosals k- Calcie Yarmosok
B Gleylc Cambisals B G-GLEYSOLS B K- Luvic Kastanozems i Ferric Podzols T Mallic Andosols ¥l= Luvie Yermaosals
BR- Humic Cambisals Gic- Calcanc Glaysols L= LLVISOLS Pg- Gleyls Podzols W To-Cchne Andosols ¥t- Takync Yermosols
W Bk- Caloc Camblsals G- Dystric Gleysols ™ | a- Albic Luvisols Ph- Humic fodzals M Ty-Vitric Andosols Yy~ Gypsic Yermasols
Bv- Werte Cambigols m Ge- Eutric Gleysols Le- Chrermic Luvisals Pl- Leotic Pedzols = - RANKERS Z- SOLONCHAKS
= fy- Gelic Cambsols Gh- Humic Gleysols LF- Ferric Luvisols Pa- Orthic Podzols - YERTEOLS 2g- Gleyic Solonchaks

W E-RENDZIMAS

G- Mallic Gleyiok

Lg- Glayie Luvisals

Lk- Calcie Luvisaks

Po- Plecic Podzals

We- Chromit Vertisels

Vo Pefliz Vertisols

Zm- Mollic Salonchaks
Zg- Orthic Solanchaks

W C- CHERNOZEMS W Gp- Pliathic Gleysals Q- ARENOSOLS

W g Glossic Chernozems 8 G- Galle Gleysals Lo= Orthic Livisols Qa- Alble Arenasols W PLANDSOLS 7t Takyric Solonchaks
W Ch- Haplic Charnozems W H- PHAECZEMS Lp~ Plinthic Luvisols Qr-Cambic Arenosols Wd- Dyseric Flanosals Watar Bodies (WA)
W (k- Calcic Chernozems M Hc- Cakaric Phasozems W Ly - Yerlic Luvisals Qf- Ferralic Arenasols ‘Wa- Eufric Planosals ‘Waber bodies (Wa)

W - Luvic Chermeerd B Hy- Glayie Phasozems M- GREYZEMS Gl Luvic Arenosals Wi-Husmse Planagals Glaciers (GL)

Salt flats (3T}

Rk debeis (RK)
Cunes/Shifting sand (05)
fio data (ND)

5.3.2 Exercise: determine how many DOMSOI categories exist in Indonesia

Classify the identified DOMSOI of Indonesia based on their Soil Class. You can find the
full name of the soil class from the DSMW legend.

Example: DOMSOI Af (Ferric Acrisol) belongs to the Soil Class A of Acrisols.
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5.3.3 Exercise: determine how many soil classes exist in Indonesia

You have now reached the point where you can identify the existing soil classes
describing soil characteristics in Indonesia, since you know the correspondence between
the Soil Class, and the SNUM codes belonging to each of these classes.

The last step for this soil reclassification is the creation of 2 tables summarizing the
work done so far. In a new Excel sheet to be named Reclass Table create a table
containing the following information (the one provided is only an example to show how
to start the reclassification):

Dominant Soil | Soil Class| Dominant Soil name SNUM
Af A Ferric Acrisols 4446| 4448| 4449
Ag A GleyicAcrisols 4455
Ah A HumicAcrisols 3640| 4457

The second table to be created needs to show a 1-to-1 correspondence between the
Soil class and a reference number. Order the soil classes in alphabetical order, and
assign each class a number starting with 1. This table will have the following headings:

Reference
soil class Soil class |Soil Class Name
num

You will now proceed with the computation of the soil parameters required by the
WFlow model.

Definition of soil parameters
We now have 16 soil classes. For each class, the 13 soil parameters that are required
as input for WFlow are enumerated and briefly described in Table 5.2 below:

Table 5.2 Soil parameters required for WFlow.
Parameter | o \pAMETERS | O™ °F | symBoL DESCRIPTION
num ref Measure
Average soll Average depth of the soll
1 m -
depth
First Zone Maximum capacity of the
2 g mm/m -
Capacity saturated store.
Saturated conductivity of the
3 First Zone Mm/timeste K store at the surface. The M
KsatVer P sat parameter determines how this
decreases with depth.
First Zone Min Minimum capacity of the
4 ; mm/m -
Capacity saturated store
Infiltration capacity of the
5 Infilt Cap Path | Mm/timestep - compacted soil (or paved area)
fraction of each gridcell
Infiltration capacity of the non-
6 Infilt Cap Soil | Mm/timestep - compacted soil fraction
(unpaved area) of each gridcell
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Soil parameter determining the
7 M i M decrease of saturated
conductivity with depth. Range:
[20-2000]
8 N - N Manning N parameter for the
Kinematic wave function. Higher
9 Nrivers NRiver values dampen the discharge
peak.
10 Path Frac o ) Frgction of compacted area per
gridcell, range [0-1]
11 Rooting Depth m - Rooting depth of the vegetation.
12 Theta R - Or Residual water content.
13 Theta S - Os Water content at saturation.
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In order to find the best estimate values for these parameters, you need to carry out an
extensive literature review or use own or existing locally available soil measurements. An
example is provided in the text box.

Computation of rooting depth

Tree roots do not occur in significant quantities at substantial depths (e.g. > 2 m)
in the soil profile. However, there are cases where isolated roots have been found
at depths much greater than this in deep and loose soils (Gilman, 1990), but
typically between 90 and 99 % of a tree’s total root length occurs in the upper 1 m
of soil.

Source: Crow P.. 2005

The information included in this manual is the result of such a review. Given your
knowledge of Indonesian local institutions working in the sector, knowledge you have
acquired in the field or from your peers, you can refine the data provided to produce a
better representation of reality for those catchments that will be the focus of your future
analysis.

In the computation sections that follow, the physical parameters for our soil categories
will be computed/estimated for each of the 8 soil categories identified in the SMAX
Word version file. This file is provided in the following directory: Soils -> FAO Soil
Moisture content -> FAO Soil Moisture). The link between the latter and our 16 soail
categories can also be derived by reading the content of this document.

5.3.4 Exercise: computation of water storage capacity of soils

Parameters 2 and 4, corresponding to the maximum and minimum water storage
capacity of the saturated layer have been sourced by referring to the information
contained in the SMAX data preparation description file. This file is provided in the Soil
data -> FAO Soil Moisture Content directory available on the USB stick. The relevant
information sourced from this file is described below.

The FAO Soil Moisture Storage Capacity dataset estimates soil moisture content
(Smax) based on soil properties and on soil types. For their physical properties, in this
dataset FAO makes a classification of soil types in 8 different families, and for each of
these, the Smax and the Easily Available Water (EAV) ranges are provided. Moreover,
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FAOQO suggests that for tropical soils (Ferralsols, Acrisols, Nitisols, FerralicCambisols and
Ferric Luvisols) the value of Smax is decreased by 10% as compared to similar textural
classes for other soils®.

The value of Easily Available Water can be interpreted as the minimum soil water
content capacity parameter, and therefore be used to estimate parameter 4 of Table
5.2. Table 5.3 summarizes the FAO Soil Moisture data.

Table 5.3 FAO soil moisture data.
Class . .
name EAV range |Smaxrange| Soil class nhame Properties
4 2
soils strongly influenced
. . by groundwater or which
W Histosol, Fluvisol, are seasonally o
(wetlands) Not applicable | Not applicable |Gleysols (all consiedred permanently flooded.
as Wetland) .
These soils groups are
considered as wetlands
soils developed from
volcanic material,
generally have very high
A > 120 mm > 200 mm Andosols soil moisture retention
capacity at both field
capacity and wilting point.
This partly limits the soils'
storage capacity
fine texture soils
B 100-120 mm 150-200 mm vertisols dominated by clay
minerals
. have very limited soil
C 60-100 mm 100-150 mm Lithosols
depth
D 40-60 mm 60-100 mm Rendzinas, Rankers shallow soil depths
Solonchaks, Regosols,
Podzols, Cambisols,
Arenosols, Vitric
Andosols, Greyzems . .
and the non-luvic soil soil groups with no
E 20-40 mm 20-60 mm ) implied clay increase with
units of the Xerosols,
depth
Yermosols,
Kastanozems,
Chernozems and
Phaeozems

°From page 7/10 of the SMAX Word version document. A reduction of 10% for this category of soils would
change the Smax value from 10 to 9 mm/m. Since this change is not significant, we will keep the
original value of 10 mm/m
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Solonetz, Podzoluvisols,
Nitisols, Acrisols,
Ferralsols and luvic units

of the Xerosols, soil groups with an

F <20 mm <20 mm implied clay increase with

Yermosols, depth
Kastanozems,
Chernozems and
Phaeozems
fine texture subasoil,
? ? ? Planosols regardless of the txture of

the topsoils

Note! FAO states: “Water availability to plants grown on Histosols, Gleysols and
Fluvisols is mainly a function of groundwater or surface water levels and flooding.
Although an Smax value can be deduced for these soils, this is largely irrelevant for
practical purposes. Hence these soil groups are considered here as "wetlands" and no
Smax is determined for them.”

Based on this information the Min and Max Soil Water Storage Capacity values for
Histosols, Gleysols and Fluvisols have been assumed to be comparables to those of
peatland. Average values of water content for peat soils have been estimated from the
measurements provided in [Katimon and Melling, 2007].

5.3.5 Exercise: computation of infiltration capacity parameters

Values for the infiltration capacity of different types of soils are difficult to find.
Information is either not available, or difficult to access. Yet, to provide soil infiltration
estimates for our WFlow computation, we can combine a set of information and tools
available through common paper and online resources. The tools provided here are the
Infiltration Capacity Curve provided by [Critchley and Siegert, 1991] and the FAO
texture composition of the soil classes (from the USB stick). You will make use of these
tools and of the information contained in the Soil data directory to find the infiltration
rates for the compacted and non-compacted fractions of our soil types.
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Figure 5.3 Infiltration Capacity Curve for Different Soil Types™®

The suggested procedure to estimate the infiltration capacity — measured in mm/day -
of soils is the following:

a. define the dominant soil type content for each of the 8 categories of soils as
described by FAO;

b. from Figure 5.3 create an 1-hr infiltration capacity table for the 4 identified soil
types, for both compacted and non compacted soils;

C. Assume an average number of hours of rainfall per day, and compute the daily
infiltration capacity for both compacted and non-compacted fractions;

d. Make reasoned judgments about your computations considering how soil texture
influences the infiltration capacity of soils;

e. By using the correspondence between our 16 soil categories and the 8 FAO soil

categories, assign to each of the latter an infiltration capacity value for the two infiltration
capacity criteria InfiltCapPath and InfiltCapSail.

5.3.6 Exercise: computation of the saturated hydraulic conductivity K¢

Saturated hydraulic conductivity (Ks) is a quantitative measure of a saturated soil's
ability to transmit water when subjected to a hydraulic gradient. It can be thought of as
the ease with which pores of a saturated soil permit water movement'’. Saturated
hydraulic conductivity is measured in ym/s (or any multiple of it). For the estimation of
the K, for our soil types, we will use the information provided in Figure 5.4 and Table
5.3.

10 Source: http://www.fao.org/docrep/U3160E/u3160e00.htmitContents accessed on 02.02.2012
" Source: http./soils.usda.gov/technical/technotes/note6.html accessed on 03.02.2012
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Figure 5.4 Saturated hydraulic conductivity for different soil types.

The Environmental Science Division (ESD) of the United States Department of Energy
provides some good literature review about computation of saturated hydraulic
conductivity based on soil type and soil texture. For more reference access the
following webpage: http://web.ead.anl.gov/resrad/datacoll/conuct.htm. Table 5.4 below

comes from the ESD and provides us with a tool to estimate K for our soil types.

Based on Table 5.4 estimate the K, values (in mm/day) for our 16 soil categories.

Table 5.4 Representative values of Ksat for different soil textures.

Satiratadd
Hydranlic

Concelnetivity
Taxturs E vy
Sand 555= 10*
ILoamy sand 495w 107
Sandy loam 105w 107
Silty loarm 22T w10
Laoarmn 219w 10
Sandy clay loam 199 = 102
Silty elay loam 5536 = 10t
Clay loarm FTa= 10t
Sandy elay S84 = 10t
Silty elay 321w 10l
Zlay 45w 10t

Sonrca Clapp and Hornbharosr (157 87
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5.3.7 Exercise: computation of the fraction of compacted area per grid cell

The computation of this soil parameter is based on best estimate taking into account
dominant soil class and the degree of soil degradation. Define this parameter according
to you best knowledge.

5.3.8 Exercise: computation of rooting depth

The estimation of the rooting depth for the FAO 8 categories of soil types should take
into account the rooting depth associated with the vegetative cover (computed in
Chapter 4), and the soil characteristics of the 8 soil categories. A thorough analysis
would first have a look at what type of vegetative cover is usually associated with a
certain soil category, and subsequently estimate rooting depth based on the
combination of predominant vegetative cover and physical soil characteristics.

During this workshop we will estimate the rooting depth for the soils based on the
information so far collected through the SMAX Word Version file and the other
mentioned documents.

Based on the sources above mentioned, make an estimate of the rooting depth (m) for
the different soil categories we are analyzing.
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6 Precipitation and potential evapotranspiration data

Precipitation

. Data source: ftp://trmmopen.gsfc.nasa.gov//pub/merged/mergelRMicro/
. filetype: bin, projection: geographic, WGS1984
. parameter: rainfall intensity every 3 hours.

The TRMM data is corrected for the bias following the method described in Vernimmen
et al. (2012).

Potential evapotranspiration

Potential Evapotranspiration (Global-PET) can be downloaded from the CGIAR-
CSIGeoPortal (http://www.csi.cgiar.org).

6.1 Preparing meteorological data as input for WFlow

Steps to make precipitation and evaporation input maps with as example the Citarum
catchment in Java are described in this chapter.

On your USB stick daily TRMM precipitation grid data for Indonesia for the year 2009
are provided. This data is in PCRaster format (.map). The file
TRMM_3B42RT_DailyCorrected_20090101.map represents precipitation for 1 January
2009 for every grid cell in mm/day, see map below (Style: freak out colors, with a
standard deviation of 0.8). The projection of this dataset is WGS84.

Figure 6.1 Precipitation (based on corrected TRMM 3B42RT) on 1 Jjanuary 2009 for Indonesia.

For the potential evapotranspiration monthly data is available from CGIAR-PET. The
format of the files is in ArcinfoAscii (.asc). The steps to make WFlow maps are for both
precipitation and evapotranspiration data the same. However the potential
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evapotranspiration are monthly data. You have to convert them to daily data. You can
do this with the raster calculator in QGIS.

6.1.1 Exercise: convert format of TRMM precipitation maps and reproject
You first have to convert the precipitation maps to GeoTIFF (.tif) format, because you

can notreproject from WGS84 to UTM when your maps are in .asc or .map. Click in
QGIS on the menu Raster; Conversion; Translate. Now this box appears:

€; Translate {Conve 2=
| Batch mode (for processing whole directory)
Input directory D:fICCPfworkshop_globaldata/QGIS)raster ftrim Select...
Qutput directary | DifICCPworkshop_globaldatafQGIs/raster ftrimy TiF Select...
Qutput Format [GDAL] GeaTIFF {* L * Liff * TIF * TIFF) A
Target RS | ] [ seeet |
Outsize [ 25% I%]
Mo data [U I%]
Expand [Gray | V]
Srewin [ ]
Priwin [ ]
Sds
Creation Options
[ame Yalue: ‘ [ Add ]
0% |
Load inko canvas when finished
gdal_translate D
[©]

Figure 6.2 Convert precipitation data in PCRaster format (.map) to GeoTIFF (.tif).

Select the batch option. With this option you can do the same conversion on all the
maps in one folder at once.

Now select as input directory the map where you have stored all the TRMM data. Select
as output directory a new folder called: Tif where you can store all the precipitation files
in TIFF format. Choose as output format GeoTIFF.

If you have followed this procedure you can view in your TIFF folder new precipitation
files are created in the TIFF format. You can open one map and one TIFF precipitation
file to check if the same value is in both maps (this is just a conversion to another
format, nothing in the values should be changed!!!).

Once all your precipitation maps are converted to .tif you can reproject them to the UTM
zone of your catchment (see exercise in Section 2.4.5).

Note! Don’t forget to tick the batch option to reproject your files all at once.
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6.1.2 Exercise: clip the meteorological maps to your catchment

You have to make a clip bigger than the catchment, because the TRMM cells have a
resolution of approximately 28 km and are crossing the boundary of your catchment.

Import a reprojectedTRMM map (created in exercise of Section 6.1.1) in your project.
Import as well the reprojected catchment layer (WS EDB — UTM54S layer created in
exercise of Section 2.3.2 or Section 2.4.5)

Now you have to choose your extent big enough for your catchment. Click on your
precipitation map and define your xmin,ymin,xmax and ymax by running your cursor
over the TRMM map and reading the coordinates in the right bottom of the QGIS
window.

Note! You can better pick a much greater window than your catchment so you are not
loosing any cells as in the example below. The clip window is here in red and the
TRMM cells remaining are colored. You can see that in the south and east cells are
missing! Because the clip window was too small there!

Figure 6.3 Wrong clip of theTRMM precipitation data.

Open the menu: Raster; Extraction; Clipper and fill in your extent. You can now see if
you have chosen the right extent. Click on the close button if your extent is correct.
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Figure 6.4 Example of the clipper functionality of the TRMM data for the Citarum catchment

Clip all the TRMM files on the extent you have chosen with the Translate function.

- Click on the Menu: Raster; Conversion; Translate

- Click on batch mode

- Input directory is the map where the projected UTM TRMM files are saved

- Name the output directory: First_clip

- Output Format is GeoTIFF

- Click on nodata: 0

- The Prjwin are the coordinates you have defined. You should fill them in the
following order: XminYmaxXmaxYmin

- Click on ok

§ Translate {Convert format} 2lx|

%] Batch mode (for processing whole directory)

Input directary [‘)Ghop_g\uba\datanGISIrasterftrimﬂT\HRepruiect_UTMszr][ Select...

Output directory  bbaldatajQGISjrasterjtrim{TiReproject_LITM_48st/First_clip | [ Select...

Output Format | [GDAL] GeaTIFF (*.tF *.tFF % TIF *.TIFF)

L4]

[ | Target SRS |Epscizzsda ) [ |
| Outsize D =
[%] Ho data [o B
[ Expand B -]
[ | Srewin [ ]
%) Prjwin | 609000 3419000 901000 51415000 ]
[ | sds
|| Creation Options
Hieme value [ aaa |

I o J

| Load inka canvas when finished

gdal_translate

B
©

o ][ o= ][ e ]

Figure 6.5 Clip the TRMM data with Translate
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Resample your precipitation data to a 270 x 270 m grid resolution.

- Doubleclick on your First Clipped TRMM grid and go to metadata.

- Go to metadata and copy the layer extent to Excel. In the Citarum case:
578548.2512440974824131, 9141899.7944292277097702 : 862061.1167209064587951,
9425412.6599060371518135. These numbers present: XMIN, YMIN,XMAX,YMAX

- Now calculate in excel how many cells of 270m. fit in your window. The same
method you used for the catchment. In the Citarum case: 1050 cells with a size of
270x270m fit in the x and y- direction of the grid.

- Go to Raster;Projections;Reproject

Click on the batch option, because you have to clip all precipitation files for 2009.

And choose resize.

The height is equal to the number of rows you have calculated in the previous step and
is for Citarum 1050. The number of columns equals the width and is for Citarum 1050.

% Batch mode (For processing whole directory)

Input directory 3frastet ftrim/ TiFiReproject_UTM_48sr)First_dlip Select. ..

Output directory teproject_LITM_4@sr [First_clip/First_resampling Select...

X! Source SRS EPSG:3274& Select...
Targst SRS [ | | select...
Resampling methad [Near | v]
Mo data values [D ]
Mask layer [ctcarum [=] [ selest |
Memary used for caching [ZDMB '%]

% Resize
width | 1050 = Height | 1050 =
0%
Use multithreaded warping implementation
Load into canvas when finished
gdalwarp D
[©]

Figure 6.6 Resample your precipitation data with the warp function

Clip the extent of your precipitation data on the coordinates defined for your catchment.

- Select the menu Raster, Conversion, Translate

- Select the Batch mode

- Select as input directory the dir where you created your rescaled clipped TRMM
grids

- Choose as output dir: TIFF_WFLOW _precipitation_catchment_....... (fill in your
catchment name at the dots)

- Select as output format: GEOTIFF

- Select as project window the coordinates you had already defined for your
catchment. (ALSO used to clip SRTM)

Click on ok.

Deltares 70



Use of Global Datasets for Hydro-
Meteorological Analysis in Areas with 1201430
Sparse Data

May 2012

Preliminary

¥ Translate (Convert format) x|

%] Batch mode (For processing whale direckary)

Input directory [ustar,itrim,l’TiF,iReprnject_LITM_48;r,l’First_cIip,l’F\rst_rasamp\inglI Select. ..

Cutput directory lwroject_UTM_485r,iWFLOeracip\tation_catchment_Citarum| I Select. ..

Output: Format [[GD,QL] GeaTIFF (. Lf * LiFf *, TIF * TIFF)

4]

[ Target sRS  |EPSG:32748 ]I Selests .

|| outsize |25°.-"o
|| Mo data |D

() [

|| Expand [Gray

|:| Srowin |

|g| Priwin [717000 9346230 544170 9195000
| | 5ds

D Creation Cptions

4

Iame Yalle ‘ [ fdd ]

Remave

) 0% ]

|| Load into canvas when finished

gdal_translate

@I

[ [o]'4 } I Close ] [ Help }

Figure 6.7 Clip your TRMM data with the prjwin in Translate

The result for Citarum precipitation grid at 6 February 2009 is as follows:

Check also your own precipitation grid!!!

2p_globaldata/QEIS raster ftrim) Tif fReproject_LITM_48sr/Second_clipf TRMM_3EB42RT_DailyCarrected_20090108. tif

Figure 6.8 Check of the clip of your TRMM grid.
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Convert your precipitation grids to asciigrids.

- Click on menu: Raster, Conversion, Translate

- Choose batch option

- Choose as input dir: TIFF_WFLOW _precipitation_catchment_.......
- Choose as output dir: ASC_WFLOW _precipitation_catchment_.......
- Choose as output_format Arc/info AsciiGrid

- Choose as nodata: -9999

® Batch mode (For processing whole directory)
Input directary  ldatafQGISiraster fhrim/TifReproject_UTM_4&st/Second_clip Select...
Output directary | D:f1CCPjwarkshop_globaldatafQGIS raster trimfasc Select...
Output Format | [GDAL] Arc/Infa ASCI Grid (*,asc * ASC) -
Target SRS [Epsciazies ][ select...
Outsize [25% =
A Mo data -9999 :
Expand IG’E‘V |Assign & specil
Srewin [ ]
Priwin [717000 9346230 544170 3135000 ]
Sds
Creation Options
e allie [ pa ]

Load into canvas when finished

gdal_translate D

oK Close: Help
Figure 6.9 Save your file as ASCII grid with Translate

Change the Xmin en Ymin coordinates and the dx and dy of the asciigrid.

QGIS does not take the exact Xmin and Ymin you have choosen to clip on. It gives a
decimal number. We do not want this decimal number because all your grid extents
should be exactly the same for the WFlow model.

- Open for the first ten days of February (1-2-2009 — 10-2-2009) with your text
editor.

- Change in the asciigrid the Xllcorner and Yllcorener to the exact values you
have calculated in step 7. (xmin_new=717000, ymin_new=9198000

- Change in the ASCIIGRID the cellsize to 270 (dx and dy)
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ncols LY
nrows 549
xllcorner  716923.866586687280 < Change the
yllcorner  9198873.587651703500 xllcorner and
dx 269.939861217450 ylicorner and cell
dy 270.0817890875599 :
feBAONDAAEAODAAABDODOOB B
OPBBOOAOABOONBEBBONDBBAD
OABAEOOAOADANDOABADOABAD
L I I O O
O O O O O O O O I
S T O O I I I
OABEOOAOANANDBEBBADOBBAD
I O I O I I I I
I
I O O O O I I I I B
PP OOGOONOABOODOBOADOBOAD

Figure 6.10  Example of the AsciigridTRMM file you have to change.

Convert the SRTM asciigrid to map file.

Convert the asciigrid to map file with: Raster;Conversion,Translate Choose as output
file format: PCRaster Raster file (*.map).

8 tronsite (Convertfoma) 0
%/ Batch mode (for processing whole directary)
Input direckory 0§ ICCPworkshop_globaldata/QaIs rasterjtrim/asc Select. ..
Qutput directory | D1/ ICCPfworkshop_globaldatajQGISiraster trimffinal_map Select...
Qutput format | [GDAL] PCRaster Raster File (. map *.MAR) -
Target SRS | | | select...
Outsize [25% }%]
%] o data 9999 =
Expand ey [~
Srcwin [ ]
Priwin [717000 9346230 844170 9195000 l
Sds
Creation Options
Hame Value ‘ [ Add ]

—— |

Load into canwas when finished

gdal_translate

K
©

Figure 6.11  Convert the ascii grid to map format with the Translate function in QGIS

This step should only be executed for the potential evapotranspiration, because this
data is monthly and you have to have daily data for WFLOW.
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Go to Raster; Raster calculator and double click at raster bands on your
Evapotranspiration file. Then divide it by clicking on the sign: /,and type in the number
of days you want to divide your monthly evapotranspiration. For example September
should be divided by 30, because September has 30 days. Then click on current layer
extent and check if this is the same as the SRTM extent. If not change it!!!! Then click

on ok.
€4 Raster calculator 2x
Raster bands Result laver
runQ0000E 1 Qutput laver
srbrn_58_14@1
testjes@l
testiesz@1 Current layver extent
3 min 499953,03468 o #Max 1054954,88414 [ =
¥ min 8890353.58235 : ¥ max 9447789.69626 :
Columns | 6024 +| Rows 6045 =
Qukpuk Format GeoTIFF -
% Add result to project
Operators
+ i sqrk sin -3 acos 4
! cos asin tan akan 1
P - = 2= o AND OR

Raster calculator expression

EVAP_2002_09_01@1 {30

Expression walid Zancel

Figure 6.12  Use the raster calculator to calculate daily potentional evapotranspiration maps

Now you have your daily epotential evapotranspiration map. You should make for every
day you want to run WFLOW a separate potentional evapotranspiration map and
rename it as follows:

Potentional_evapotranspiration of day 0 =>PET00000.000
Potentional_evapotranspiration of day 1 => PET00000.001
Potentional_evapotranspiration of day 2 => PET00000.002
Potentional_evapotranspiration of day 3 => PET00000.003
Potentional_evapotranspiration of day 4 => PET00000.004
Potentional_evapotranspiration of day 5 => PET00000.005
Potentional_evapotranspiration of day 6 => PET00000.006
Potentional_evapotranspiration of day 7 => PET00000.007
Potentional_evapotranspiration of day 8 => PET00000.008
Potentional_evapotranspiration of day 9 => PET00000.009
Potentional_evapotranspiration of day 10 => PET00000.010
Potentional_evapotranspiration of day 11=> PET00000.011
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Etc.....(The format of the name of the file should not have more than 12 characters.
Therefore at timestep 100 => PET00000.100)

The rain maps should be renamed as follows:
TRMM of day 0 => P00000.000
TRMM of day 1 => P00000.001
TRMM of day 2 => P00000.002
TRMM of day 3 => P00000.003
TRMM of day 4 => P00000.004
TRMM of day 5 => P00000.005
TRMM of day 6 => P00000.006
TRMM of day 7 => P00000.007
TRMM of day 8 => P00000.008
TRMM of day 9 => P00000.009
TRMM of day 10 => P00000.010
TRMM of day 11=> P00000.011
Etc..
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7 Extra exercises

71 Preparing input data for WFLOW with QGIS for Bian and Citarum

This section will guide you through the steps to be performed to prepare part of the
input maps required to run WFlow. The data preparation is run for the Bian and for the
Citarum catchments, at a 270 and 1080 m cell size resolution.

We will analyze the steps to produce land cover, soil and elevation maps for the year
2008. Precipitation and evapo-transpiration maps will be provided by the trainers.

The exercises included in this section are a repetition of the work performed during the
previous workshop, therefore explanation about the procedure to perform them will be
synthetic and to the point. Refer back to the appropriate sections of the manual if you
have any further doubts.

During this workshop and therefore during the map preparation phase we will work in
UTM projections. Therefore you always have to make sure that your reference
coordinate system is set to this projection. If this is not the case, then you should re-
project your layers to the UTM grid corresponding to your catchment, or change the
CRS from the project settings. The UTM reference grids that apply to your catchment
are:

Citarum catchment: UTM 48S
Bian catchment: UTM 54S

The exercises we will perform are the following:

Exercise 1: Identification of the extent for the clipping of the maps
Exercise 2: Clipping of the DEM, land cover and soil maps

Exercise 3: Re-projection of the DEM, land cover and soil maps to UTM
Exercise 4: Resizing of the maps to 270 and 1080 m resolution
Exercise 5: Conversion of the input maps into .map WFlow format

Each exercise will provide instruction for both catchments. Follow only the instruction
for your assigned catchment.

For the preparation of the new layersand for the correct naming of the files you will be
producing during the exercises, please use the nomenclature reported below.

Final output maps:
1. Elevation maps
a. SRTM_270_Bian (.tif );
b. SRTM_270_Bian (.map);
c. SRTM_1080_Citarum (.tif);
d. SRTM_ 1080_Citarum (.map);
2. Land cover maps
a. LC 270 Bian (.shp);
b. LC_270_Bian (.map);
c. LC_1080_Citarum (.shp);
d. LC_1080_Citarum (.map);
3. Soil maps
a. Soils_270_Bian (.tif );
b. Soils_270 Bian (.map);
c. Soils_1080_Citarum (.tif);
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d. Soils_ 1080_Citarum (.map)

Exercise 1: Identification of the extent for the clipping of the maps

The identification of the extent for the clipping of the maps is required to delimit the area
of analysis and abstract the required data from the global or regional maps. In order to
correctly run WFlow, all the input maps need to have the same extent. We will first
define the extent of the clipping around the hypothetical area of the river catchment,
and then proceed with the clipping of the input maps.

Ideally, you should be able to define the right extent of the clipping by taking into
consideration the DEM and the river layer. If other information is available, you can use
it to make your clipping selection more accurate.

An alternative way of proceeding is to identify which are the provinces or districts where
the river is flowing, and use an administrative boundary layer to identify the clipping
extent. In the following exercises we will proceed following this reference mp (the
administrative layer), although you can also choose to give priority to the DEM, or
combine information from the latter with the administrative boundary layer.

Procedure:

1. Open Q-GIS and create a new project called Workshop_Bogor,

2. import to your project the administrative boundary layer from the Admin boundaries
folder;

The Citarum catchment is located in Jawa barat province, while the Bian catchment is
located between the Merauke and Boven Digoul kabupaten in Papua province.

3. Identify the administrative units above mentioned and create a polygon around this
area.

To create the polygon from a vector layer select: Layer -> New -> New shape layer.
This exercise has already been described in section 2.3 of the manual.

When the new screen pops-up you have to define the characteristics of the layer (for
Type select Polygon, for Type in the New Attribute selection select whole number, give
the name of the new attribute poly and then select add to attribute list, click ok). Save
the layer with name Bian_ polygon or Citarum_polygon. Leave the CRS to the WGS
84. The layer will appear in your layers map. Right click on the layer's name and select
Toggle Editing to start editing your feature based on your criteria of selection.
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Figure 7.1 Example new attribute table for Bian

Start creating your polygon around the identified administrative boundary by clicking
around the contour of the corresponding polygons. When you have finalized your
editing, right click with the mouse to stop the toggling and save the file. If you still see
a pencil icon on your layer icon on the Map Legend, this means that you have not
closed the Toggle Editing function in the layer. Close the editing function if you see
this icon.

4. Note down the extent of the clip and round it to the nearest integer;
You can perform this action by right click on the layer and read the coordinate from the

properties header. This is the extent that you will be using to clip all the input maps for
your catchment.

Exercise 2: Clipping of the DEM, land cover and soil maps

import the SRTM, soils and land cover layers;

For the groups working on the Bian catchment this step requires the merging of two
SRTM maps. Perform the merge first, and then use the merged layer for the clipping.

clip the above mentioned maps on the polygon extent identified in step 4;

To perform this operation you could clip the input maps one by one or you can chose to
speed the clipping process by using the batch option. This option is available from the
following path: Raster -> Conversion -> Translate.

The batch function gives you the possibility to perform the same operation (in our case
the clipping) on files and layers contained in a same folder. Therefore it | needed that all
the input layers you want to clip are contained in the same folder.

Move the 3 input layers you want to clip (SRTM, land cover an soils) to a new directory
to be named Clipping Folder, and perform the clipping operation from the Conversion ->
Translate path.
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To complete the operation you need to specify a (previously created) output directory,
and the right extension of the clipping area from the Prjwin selection. Remember that
the order of input for the coordinates in the Prjwin field is different from the input order
of the coordinate system from the Properties window of the vector layer. The
coordinates in the Prjwin field have the following order: Xa, Ya, Xb, Yb (XMIN
YMax,XMax,YMIN).

r

)

Pay attention to this different order to define the right extent of your clipping area.

®| Eatch mode (For processing whole directory)

Input directory = fWorkshop Bogor May 2012 /DatafInput data/Clipping Folder Select. ..

Cutput directory | EfWorkshop Bogor May 2012/Data/Resulks/Clipped files Bian Select. ..

Cutput Format [EDaAL] Al Files (*) I
Target SRS |EPsEi43z6 | | select..
Outsize [25% =
Mo data [D l%]
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Srowin [ l

X Prijwin I I
Sds

|Selects a subwindow from the source image For copying (like -srowind but with the corne
Creation Options

[dame | Walue | [ add l

Remaoye

) 0% |

® Load into canvas when finished

Figure 7.2Clipping with translate

Check your results. The clipped maps for soil, land cover and SRTM should include all
of the area of the polygon you created. If for example the results of the clipping lead to
a results such as the one showed in Figure X below, you should redefine the extent of
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the clipping area to include those parts of the polygon that are lefts outside of the
clipping selection.

€} Quantum GIS d5431b3 - Workshop_Bogor
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Figure 7.3Clipped area outside map

After the review of the clipping extent your clipped maps should look like in Figure X2
below.

Figure 7.4Result polygon for Bian

Note down the coordinates of one of the clipped layers (SRTM, land cover or soil map).
You will need this information later on to define the exact extent of the ASCIlI maps to
be used to create the WFlow .map input layers.

Exercise 3: Re-projection of the DEM, land cover and soil maps to UTM

Identify the UTM zone for the re-projection of your input maps. Once you have found it,
use the Warp function and the batch mode to re-project the input maps from WGS to
UTM.
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Check the results of your conversion from the properties option of the new layers.

Exercise 4: Resizing of the maps to 270 and 1080 m resolution

The procedure for the resizing exercise has already been dealt with during the first
workshop. You can find reference to the procedure to be used in Section 6.1 of the
Manual (page 70).

You have to adjust your computations to obtain a resolution of 270*270 and
1080*1080m respectively.

Perform the following procedure:

1. open the layer properties of your 3 input layers, copy their coordinates (Xmin,
Xmax, Ymin, Ymax) in an excel sheet and compute the X and Y dimensions of the
layer as follows:

a. Xdimension: Xmax — Xmin
b. Y dimension: Ymax -Ymin

2. determine the number of columns and rows representing respectively the width and
height of the new resized layer;

3. go to Raster -> Projections -> Warp select the batch mode, select the input
directory and insert the width and height data in the resize field;

The resized files are still in a .tif format. In order to ensure that we will use the same
extent for all the input maps we have to manually modify the Xmin and Ymin
coordinated. This is doable by operating on ASCII files. You need therefore to convert
the resized layers from .tif to .asc by using the Translate function. Use the batch mode
to convert all the input layers.

Change the Xmin en Ymin coordinates and the dx and dy of the asciigrid.

QGIS does not take the exact Xmin and Ymin you have chosen to clip on. It gives a
decimal number. We do not want this decimal number because all your grid extents
should be exactly the same for the WFlow model.

- Open your input maps with the text editor;

- Change in the asciigrid the Xlicorner and Yllcorner to the exact X and Y
coordinate values of the catchment polygon you have created at the end of
Exercise 1.2;

- Change in the ASCIIGRID the cellsize to 270 or 1080 (dx and dy)

. TextPad - D:',JCP MERAUKE' Workshop Bogor May 2012'\Data'Results'Clipped files Bian_UTM_1080_AsC'GlobC

File Edit Search View Tools Macros Configure  Window  Help

NDEEH aB8E2hE tBERla ==209 DY 2R G eu »

GlobCover selection on Indonesia.a... ]
AMNSI Characters ™ neols 205

nrows 08

xllcorner 278400

vllcorner 004800

d= 1080

dy 1080
14 14 20 160 1e0 40 40 1e0 20 40 20 20 20 14 40 40 40 40 40 40
14 40 1e0 20 40 14 20 160 20 20 40 20 14 20 40 40 40 40 40 40 3

Figure 7.5 Example header asciigrid

Exercise 5: Conversion of the input maps into .map WFlow format
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The last step is to convert the layers from ASC to MAP format. You can do this by
making use of the Translate function.

Your elevation, land cover and soil maps are now ready to be used in WFlow since:

- they are on the same projection;
- the y have the same resolution;
- they have the same coordinates extent

WFlow also requires the precipitation and ET maps as an input to run the simulation.
Contrary to the previous one, these maps are not static maps, as their values change
day by day. The procedure to generate these maps has already been presented during
the previous workshop (use of the batch mode).

In order to ensure homogeneity in the data preparation phase, we will provide you with

all the required input. This exercise was meant to make you review the main tools and
functions that you need to know to perform the data preparation before running WFlow.
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8 Hydrological modeling with WFlow

This section describes the functioning of the Hydrological model WFlow, and provides
the required background information on the GIS environment PCRaster.

WFlow is a distributed Hydrological model which has been built using a dynamic GIS
language called PCRaster. The PCRaster version used in WFlow is a beta version that
allows for programming in Python language. The PCRaster main software can be
downloaded from http://pcraster.geo.uu.nl/. This webpage also contains information
about the program, its development and its functionalities.

WFlow has already been used in the Citarum catchment to model one drought pilot
project, and in 2011 for a flood risk study carried out by Deltares. Information about the
latter is provided in the USB stick, in the WFlow directory.

There exist two versions of WFlow, one based on the HBV model, and another based
on the TOPOG SBM (Australian) model. The version we will be using during this
workshop is the one based on the TOPOG SBM model. This is because this version
also computes subsurface lateral flow. In order to run WFlow, both PCRaster and
Python version 2.5 needed to be installed.

8.1 Basics of WFLOW model functioning

WFlow is a distributed' hydrological model developed by Jaap Schellekens from
Deltares. The model is derived from the CQFlow model (Kohlet et al., 2006) which has
been used in different countries (most notably Central America). The model is
programmed in a dynamic GIS environment with PCRaster. The PCRaster version used
in this version of WFLOW is a beta version which allows for programming with Python
language. Through the latter it is possible to create scripts that execute given
computation in bundles. In order to run the model, version 2.5 for both PCRaster and
Python is needed.

WFlow models the processes of the hydrological cycle. They are schematized in figure
Figure 8.1 Processes in the hydrological cycle The processes of the hydrological cycle
are modelled with a combination of sub-models which are nested in the program. The
sub-models are:

1. Rainfall interception (schematized by the Gash model)

2. Rivers(channel) and overland flow modeled with the kinematic wave reservoir
(fast runoff reservoir)

3. Soil processes schematized by the TOPOG_SBM model

These principles of these three hydrological sub-models in WFLOW are in the following
three chapters explained

2 The opposite is a lumpedhydrological model, where what happens in the rainfall-runoff transformation is
unknown (black box model). A distributed model allows for the definition of parameters at the analytical
scale, and in principle, it is possible to compute the discharge for each cell of the grid included in the
model.
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Figure 8.1 Processes in the hydrological cycle

8.1.1 Rainfall Interception

Interception 13" refers to precipitation that does not
reach the soil, but is instead intercepted by the leaves and
branches of plants and the forest floor. It occurs in the
canopy and in the forest floor or litter. Because of
evaporation, interception of liquid water generally leads to
loss of that precipitation for the drainage basin, except for
cases such as fog interception.

Figure 8.2 Interception

Interception (precipitation) is modelled with the Gash model, which allows modelling with
daily precipitation time steps (when running the model with sub-daily time steps, an
adapted version of the Gash model is used).
The analytical Gash model of rainfall interception is based on Rutter's numerical model.
The model calculates the amount of rainfall needed to reach saturation of the canopy
The Gash model is a model for rainfall interception by trees in a forest. It gives a
formula for the threshold value necessary to saturate the canopy:

RS E

P, = _Tln 1 - <
E R(1—p—p:)

Wherein

P' = threshold value necessary to saturate the
canopy

R =averageprecipitation intensity on a saturated
canopy

E =averageevaporation from the wet canopy

S =canopy capacity

p =directthroughfall coefficient

p; =proportion of the rainfall diverted to stemflow

Figure 8.3 Processes Canopy

'3 hitp://en.wikipedia.org/wiki/Interception_(water)
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8.1.2 River and overland flow

Water which not infiltrates in the subsoil is fed to the open water. Also when the subsoil
is fully saturated, the surplus of water is fed to the surface water. The water flow of the
open water is computed by the kinematic wave equation.

Kinematic waves will not be accelerating appreciably and the flow will remain
approximately uniform along the channel. No visible surface wave will be noticeable
and an observer on a bank will see the flow as an apparently uniform rise and fall in the
water surface elevation over a relatively long period of time with respect to the size of
the specific subbasin being analyzed. Therefore kinematic waves are often classified as
uniform unsteady flow.

Wflow uses for the kinematic wave we use the Manning equation which is expressed
below.

k

vV ==R/".5?
T

Wherein:

V is the cross-sectional average velocity (L/T)

k is a conversion factor of 1 (L"*/T, m"/s)

n is the Gauckler-Manning coefficient, it is unitless

Ry is the hydraulic radius (m)

S is the slope of the water surface or the linear hydraulic head loss (L/L)
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8.1.3 Soil processes in WFLOW

For the soil water component, WFlow embeds the TOPOG_SBM model developed by
Vertessy and Elsenbeer (1999). In this model, the soil is considered as a bucket with a
certain depth (z;), divided into a saturated (S) and an unsaturated (U) store, the
magnitudes of which are measured in units of depth.

Netto Precipitation
(without
interception)
Interaction Open

Evapotranspi- water
ration ’

Unsaturated T l I ~
Store
Unsaturated
: Store
Exchange based Soil
accuflux limited by on Ksat at water Schematization
Ksat horizontal table

Figure 8.4 Soil processes modeled in WFLOW

Within WFlow, water movements in the soil are modelled as follows: Water for
transpiration is first taken from the unsaturated store U.Transpiration is the loss of water
vapor from parts of vegetation especially in leaves but also in stems. Evapotranspiration
is modelled from the potential evapotranspiration which is refined based on soil water
content and vegetation type.

If the U store cannot satisfy the demand for water, the saturated store S is used if the
pseudo water level is not below the rooting depth.

Precipitation (minus interception) is added to the unsaturated store. Any surplus is fed
into the open water schematized by fast runoff reservoir (calculated with kinematic
wave). Water infiltrates from the unsaturated to the saturated store according to the
value of the saturated hydraulic conductivity

Lateral subsurface flow is modelled using the Darcy equation, which describes the
patterns of water flow formulation and velocity in a porous medium. In Darcy’s law, the
discharge Q (m3/s) is calculated as the ratio between the hydraulic conductivity
coefficient k (m?/day), the cross-section of the area A (m?) for which the discharge is
calculated, and the difference in porous pressure exercised (Pb-Pa) on the one hand,
and the product between viscosity y (Pa s ) and the length L (m) of the area over which
the change in hydraulic pressure takes place.

o kAWM = P,)
In
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The negative sign in the equation is required to counterbalance the negative value that
may arise when calculating pressure differences;

Equations of the vertical transfer between unsaturated and saturated zone

The top of the saturated store S forms a pseudo-water table at depth z such that the
value of S at any point in time is given by the following equation:

5= (Zp — Z,-}lfﬂ,- — Hr]

A

U = TotalDepth - S

where 8s and 6, represent the saturated and residual
soil water content respectively.

On the other hand, the unsaturated store U is
subdivided into two sub-buckets of storage (Us) and
deficit (Uy) which are again expressed in units of
depth:

U = (f: —8)z — U, otaldept

with:
L. =L -l

The saturation deficit (S4) for the soil profile as a whole is defined as:
Sﬂ' — |:H:c = Hrj:f —= 5

WFlow assumes an exponential decay of the saturated hydraulic conductivity of soils
(Ksat) depending on soil depth.

In the model, the rate of saturated hydraulic conductivity exponentially decreases with
depth according to the following relation:

- s oA —fT)
h:i.':r‘ = I‘tllt =

where:

Ky is the saturated conductivity at the soil surface, measured in [m d”']

fis the scaling parameter defined based on the ratio between the difference of (6 - 6;)
and a model parameter M. The f parameter is measured in [m™].

Saturation conditions are assumed to occur when rainfall intensity exceeds a given
threshold. Often the 0.5 mm/hr threshold is used for computation.

Calibration

If existing discharge measures are available, WFlow allows for calibration of the modeled
results to the field measurements. This is done by filling in a .tss file format from the U
command.

Calibration is mainly carried out by modifying the M parameter, which is a model
parameter that determines the value of the f factor when computing the saturated
hydraulic conductivity K. from the saturated conductivity at the soil surface K,

Required input data to run the model are stored in a case, which also includes a

subdirectory where all the results of the model’s run are saved. When the user wants to
preserve existing model results, he/she needs to specify a distinct ID run for the new
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simulation. If not differently defined by the user, WFlow generates a default case where
to source and store data. The model only works with a case at a time.

8.2 Input data for WFLOW
WFlow requires the following input data to run:
A. Static data
DEM
Soil depth
Soil physical parameters
Land Cover/Land Use map
Dynamic data
Precipitation
Potential evapotranspiration

TP WRO T O

These two categories of input data are contained in the Staticmaps and Inmaps
directories respectively. The static maps are all in a .map raster format, and can be
directly produced in GQIS or with available scripts. WFlow uses these input maps to
generate the discharge series for the identified catchments.

8.3 Delineate the catchment and create the static maps

The delineation of your catchment can be done by a prepare script which also
makes your other static maps in the right extent automatically. A python script is
available that can perform the delineation of your catchment and resizes your static
maps in the same extent and resolution needed for WFLOW.

The script does the catchment delineation by doing a terrain analyses. It calculates
the slope of your DEM and calculates the direction of your flow by the slope of your
DEM within taking into account the geographical location of your gauges and the
rivers. The rivers are at burned in the DEM with a depth of 200m. When water flows
into the river, the water can not get out of the river, because water can not stream
to a higher altitude. You have to choose the location of your gauging point yourself.
You have to think thoroughly about what is the best location. Therefore look at the
DEM and your rivers and think: Where will the water flow to and from which
catchment do | want to know the runoff. Always choose your gauging point on a cell
with a river!

Figure 8.5 Calculation of the direction of your flow over the DEM
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In order to run the script, both PCRaster and Python 2.5 and the following data needs
to be present:

8.3.1

O
O

a DEM in arc/ascii or PCRaster format

a land use map in arc/ascii or PCRaster format. If the resolution is
different from the DEM the script will resample this map to match the
DEM (or the DEM cutout).

The locations of the gauges. The first gauge should be the catchment
outlet.

The extent and cellsize of the out maps.

Exercise: Catchment delineation

Step1: Install the programs if you did not install it the previous workshop. In
order to run the script, both PCRaster and Python 2.5 must be installed:
Open the folder: step1_install python and PCRaster and click on
installall.bat All the programs you need to determine the catchment
deliniation will be installed.

Step2: Open the wflow_prepare.ini and look in the file. This is initial file read
by the script that is making the catchment delineation which you will be
running with the batch file: create_maps.bat. The python script needs the
wflow_prepare.ini file to know which DEM, landuse map and locations of the
gauges it has to use. The format of this file is in txt and you can edit it easily
in your txt editor.

Before you edit the file you should copy your SRTM map to the same folder
as the prepare.ini and the create_maps.bat and rename it to dem.map.

Masterdem=dem_scalar (You should not change this name!!!)

Landuse=............. => (we are not going to use this map now)
Soil=............. => (we are not going to use this map now)

river=............. => (write here your path and name of your river shape)
gauges_y =1........ ]=> (write here your y coordinate of your catchment
outlet)

gauges_X =[........ ]=> (write here your x coordinate of your catchment
outlet)

Yul=....... =>(Write here your upper left Y coordinate of the output map)
Xul=...... =>(Write here your upper left X coordinate of the output map)
Yir=......... => (Write here your lower right Y coordinate of the output map)
Xlr=......... => (Write here your lower right X coordinate of the output map)
cellsize = ...=>(Write here your Cellsize of your output map)

Choose as cellsize and the extent (YUL, XUL, XLr and YLr) for your output
map the SRTM map (you have created this morning). You can view the
cellsize and extent of your SRTM map in QGIS (right mouse click on your
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map, properties, metadata). Save the wflow_prepare.ini in the same map
your scripts are in.

o Step3: Double click on create_maps.bat and the script for the catchment
delineation starts running,once the python script has finished successfully
the following maps are created in the step2

wflow_landuse.map
wflow_subcatch.map
wflow_gauges.map
wflow_catchment.map
wflow_river.map
wflow_streamorder.map
wflow_dem.map
wflow_ldd.map
catchment_cut.map
wflow_riverlength_cut.map
wflow_riverburnin.map
cutout.map

O O O O O 0O O 0O O o0 o0 oo

The Idd.mapstands for local drainage direction map. This map shows the
direction of the runoff. You can open this map with your aguilla viewer. The
aguila viewer is in the directory where you installed PCRasterin the folder apps
(c:\Program Files\PCRaster\apps\aguila.exe). From the calculation of the local
drainage direction WFLOW defines the catchment. The other maps you can also
view in QGIS. Look at you DEM map and your rivers and then check if your
defined catchment is ok!

Open the wflow_river.map and the wflow_DEM.map and the catchment map you have
produced in QGIS. Do you think the catchment map looks good that the program
produced and why or why not?

Open the step2\wflow _catchment.map and the step2\wflow_subcatch.map.
Compare the maps. What is the difference and why?

Open QGIS and open the created maps: stepi1\streamorderrive.map and the
step2\wflow_river.map. What is the difference between both maps? Do you understand
what the numbers stand for?

8.3.2 Exercise: making static and instate maps
For WFLOW you need staticmaps. The static maps can be produced by the script
which you also used in the previous exercise about catchment delineation.

¢ With the catchment delineation you can also define the extent of your
model. Open the wflow_catchment.map in QGIS and write the upper left x
and y coordinates and the lower right X and Y coordinate down. Don’t
choose your model too large, otherwise the calculation time will be very
high. So not choose it smaller than your catchment otherwise you loose
water. Fill the new extent of your maps in
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8.3.3

Run the create_maps.bat.Rename the folder step2 to staticmaps_1.

Open the wflow_subcatch.map and the wflow_river.mapin QGIS from the
staticmaps_1.

Open the wflow_prepare.ini file and put a # before the river. This means the
rivers are not used by creating the catchment. After running the script again,
rename the folder step2 to stacmaps_noriv. And open the wflow_subcatch.map
in QGIS. Compare this catchment map with the previous made one. Do you see
difference and why?

Open QGIS and look at the wflow_river.map. Choose an extra gauging point
upstream in your catchment exactly on a river cell. Write down the x and y
coordinates of this gauging point. Open again the wflow_prepare.ini file and
remove the # before the river. Now go to gauges_y=[...] and put a comma
behind the first y-coordinate and fill in your y-coordinate. Do this also for your x-
coordinate. Now run the create_maps.bat again and open
step2\wflow_subcatch.map in QGIS. What is the difference with the other
catchments?

Exercise: Run WFLOW model

To run the wflow model we will use the modelof theBian and Citarum provided
on the usb-stick. Now double click on therun_Bian_1080.bat, run_Bian_270.bat,
run_Citarum_270 or run_Citarum_1080.bat and WFLOW starts running. Look in
the batch file: For Bian:

bin-wflow\wflow_sbm.exe -C Bian_1080 -T 3562 -s 86400 -R result

The first term is the executable which runs your WFLOW model. The rest is
input for WFLOW to run. —C gives the name of the case and input data directory
you are running —T gives the total timesteps, -s gives the number of seconds for
one timestep, -R gives the name of the result directory.

Open the wflow_sbm.ini (you can find it in the input data directory) in your text
editor. Make sure the sizeinmetres is set to 1, otherwise WFLOW thinks your
maps are in lat long (degrees). The output maps are given in maps
[Ouputmaps] and in daily timeseries [outputtss]. If you write a # on the start of
your line it means WFLOW will not read this line. Open in your wflow model
directory (Bian/Citarum) result\run.tss with your text-editor. This is the
averagedaily runoff for your catchment WFLOW calculatesin m3/s. You see
more columns because you get the runoff for every sub-catchment. If you have
for example 2 catchments you see in the tss-file 2 columns. For each catchment
1 column. Do you know which catchment belongs to which column?

Copy the runoff from the tss file in excel and make a graph. What do you think
your initial state for the water level was? (Tip: Look in your runoff graph at
timestep zero).

Open the instate folder and copy the maps from the result\outstate directory to
this folder. Why do you think we do this?

Run the wflow model again with the .bat file and look and copy the runoff from
the tss file again to excel. Compare this runoff to the previous modelled runoff.
What is the difference?

The output maps are in \result\outmaps. The extent of the output map is a
number which shows the timestep of your output.
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8.4 Create the parameter tables for WFLOW

The parameter tables are one of the input directories for WFLOW. It contains the values
for the parameters used in the model. The number of parameters

varies with the version of the model. This version has 18 different parameter tables.

Raw data

Praciptaton mep Bvape Trangpiration mep e 5ol
e // ey / /mtf:? rovein Sl B A R

Preparing of| data

Input data for WFLOW
Running of WFLOW

Figure 8.6 The preparation of the parameter tables in the bigger picture for the use of WFLOW.

The first and most time consuming part is getting the parameter data (upper right in the
scheme) to base the values on. When the values are estimated it has to be put in the
right format for wflow to read, using notepad (upper right green in the scheme) or
another basic text editor. This is in a table with the extension .tbl which is part of the
directory intbl for WFLOW (the right blue box in the scheme).

8.4.1 Parameter data

In theory the parameters are linked to the soil map, the landuse map and to the
subcatchment map (produced based on the gauging points) (all part of the staticmaps).
Probably the parameters won’t change much per subcatchment so practically there are
three kinds of parameters; parameters dependent on the kind of soil, parameters
dependent on the landuse and parameters with only one value, not dependent on

anything.

Reclassification Value in FAO Texture
It will be difficult to find information about exactly _the maps  classification _ class
the kinds of landuse and soil in the maps. 4448 Af55-3b Clay
Therefore before searching the internet it is 4469 Ap27-2a Loam
good to make a reclassification yourself. 4513 1-Od-U-1c Sandy

For the soil it is very useful to make a

I g P e 3 T 7 he DEN
classification based on the texture, an example wover the
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for some kinds of soils is in
. Information about the texture (including some Value in FAO Texture
other information) of the soils can be found with ~_the maps  classification  class
the HWSD viewer (in the directory ‘Harmonized 4448 Af55-3b Clay
world soil database’ in the stick in the Tuesday 4469 Ap27-2a Loam
directory). 4513 1-0d-U-1c sandy
For the landuse just make an easy Legrn

understandable classification, for example
making use of descriptions like; deciduous forest, shrubland, wetland, crops, open
water, etc.

8.4.2 Sources
It is good to have in mind that the values that will be finally chosen always remain
estimates. It is probably not possible to make measurements yourself in the area to
determine the values of the parameters but on the other hand some research about the
parameters is necessary to get a more reliable model.
Depending on the amount of time that can be spend on the research, the estimates can
be more solid and in more detail. Sources to think about (from more generally to more
detailed) are:

- Wikipedia

- Other internet sources

- Books/articles about standard values (e.g. FAO, US department of Agriculture)

- Experts (e.g. colleagues, Dinas Pertanahan, BWS)

- Measurements (e.g. Bakosurtanal)

- Scientific articles with measurements of comparable areas

In Tabel 8-1 is an overview of the parameters with a description, dimension, possible
sources and normal values.

Tabel 8-1 The parameters with a description, dimension, sources and normal values.
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Dimensio Norma Relate Possible Descriptio
n lvalue dto Source n
range
Albedo - 0-1 Land (Wikipedia) The
use (Lutz Breuer, reflecting
2003) power of a
surface.
Beta - 0.6 Single  (Schellekens Used in the
value , 2011) kinematic
wave
function.
CanopyGapFraction - 0-1 Land (Schellekens  Fraction of
use , 2011) the surface
which is not
covered by
a canopy.
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EoverR - 0-1 Single (Schellekens Ratio of
value , 2011) average
wet canopy
evaporation
rate over
average
precipitation
rate.
FirstZoneCapacity mm 0- Single (Schellekens  Maximum
20000  value , 2011) capacity of
the
saturated
store.
FirstZoneKsatVer mm/day 0- Sail (Natural Saturated
10000 Resources conductivity
Conservation of the store
Service) at the
surface.
FirstZoneMinCapacit mm 0-400 Saoll (Decagon Minimum
y Devices, capacity of
2012) the
saturated
store.
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InfiltCapPath

Dimension

mm/day

Normal
value
range

Related
to

Single
value

Possible
source

(Schellekens,
2011)

Description

Infiltration
rate of the
compacted
soil (or
paved area)
fraction of
each
gridcell.

InfiltCapSoil

mm/day

25-750

Soil

(Brouwer,
1990)

Infiltration
capacity of
the non-
compacted
soil fraction
(unpaved
area) of
each
gridcell.

LeafArealndex

0-10

Land
use

(Lutz Breuer,
2003)

One half the
total green
leaf area
per unit
ground
surface
area.
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M - 20- Single (Schellekens, Soil
2000 value 2011) parameter
(Brooks, Boll, determining
& McDaniel, the
2004) decrease of
saturated
conductivity
with depth.
MaxCanopyStorage mm 0-10 Land (Lutz Breuer, The
use 2003) maximum
canopy
storage.
N - 0.01- Land (Alfred J. Manning
04 use Kalyanapu1, roughness
2009) parameter.
N_River - 0.02- Single (Schellekens, Manning
0.15 value 2011) parameter
for the river.
PathFrac - 0-1 Land (AMEZQUITA Path fracis
use Edgar) compacted
area per
grid cell.
RootingDepth mm 0-5000 Land (Kazuhito Rooting
use Ichii, 2009) depth of the
vegetation.
thetaR - 0.001-  Sall (Wikipedia) ThetaRis
0.1 (Fisher, residual
2000) water
content.
thetaS - 0.2-0.5 Sall (Wikipedia) Theta S is
(Fisher, water
2000) content at
saturation.
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8.4.3 Making the input table with the text editor
Now the values are determined but they have to be in the right format for WFLOW. For

example the N table:
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% MED - unregistered - [d:\Bouke Pieter\EDE data\Workshop May\Wflow data\Input data\Bian_270\intbl\thetaS.tbl]
& File Edit Block Search Macros Plugins Tools Project  View Windows Options  Help

S == Q ab B Wiy e MEEGH S
F'miect] Windows TEHlLib] M.thl thetaS.thl

At |.t’-'«NSI-I:harac:ters j [8,> [8,> 8 a.5

[8,> [0,> hanug 0.2

% | [8,> [0,> 4469 8.5
T\ |l [98,> [8,> s4708 8.5

% [ [8,> [0,> 4480 6.5

% 35 i [8,> [@,> 4483 8.4
r 3 [8,> [0,> 4513 6.4

S =[| [8,> [0,> 4524 @.25
g [#,> [8,> 4555 0.25
no [8,> [8,> 4556 0.25
11 ] [8,> [®,> 4557| 0.25
2k

The values have to be put into a normal text-file and get the extension .tbl. This kind of
file can be made by a basic text editor like MED or notepad. The first column stands for
the landuse, the second the subcatchment, the third the soil and the fourth the
parameter value. It should always consist of four columns! The values in the first and
third column, so for the landuse and soil, should contain exactly the values as they are
in the landuse and soil maps. The second column, the subcatchment, which refers to
the map wflow_subcatch which is one of the staticmaps will not be used.

[0,> means values equal or larger then zero will have the same parameter value. This
option makes it possible to link a range of values to the same parameter value.

As described before the files have to be saved as <parametername>.tbl and put in the
folder intbl in the wflow case directory.
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8.4.4 Exercises with the tables
Execute these Exercises with your group, do it for the catchment assigned to your
group. Read first the exercise together and split tasks. If you don’t know how to perform

the exercise read again the pages before where it is explained.

1. Find the kind of soils that are present in your catchment. An easy method to do
it is to open your prepared soil map based on FAO values with aguila.

C:h\ResultsyOutpu

I 0

[ 44689
[ 4524
[ 4555
I 4556

Figure 8.7 soil map viewed with aquila

2. Find the soil texture for the soils in your catchment (with HWSD viewer as
described three pages up under reclassification), the texture is presented with
sand, silt and clay fractions. Determine the texture class of all the kinds of soil in
your catchment (to find a classification search for soil texture triangle in google).

? HWSD-Viewer
Data Help

BEMS P #2808 o8R0 S

fu Tah\eb

File View Window

D ¥

[ || & &
Ll B Lisisal - L% -
¥ 2l W Mitisal - NT
W =l B Podzaluvisal - FD
| B Phagozem - PH
&l Planosol - PL

W HWSD Soil Groups

S
# LI B Fiinthosol - PT
; = Podzal - FZ
L -kl FegosolRG
P HWSD Soil Mapping Unit Details =] 1 [
Cotage T Selected SMU's
Soil Mapping Unit 4575 4575 v]
Dominant Soil Group AN - Andosols
Dominant Soil Assodated Seils and Indusions
Drainage dass (0-0, 5% slope] Moderately Wel Moderately Wel Moderately W =
AWC (mm) 150 150 150
s | Gelic Properties No Mo No
Vertic Properties Mo Mo Mo
Petric Properties No Mo Mo
TOPSOL (0-30cm). I »
Topsoil Sand Fraction (%) 31 46 47
Topsoil Silt Fraction (%) 49 43 34
Topsoil Clay Fraction (%) 20 11 19

loam loam

Topsoil USDA Texture Classification

[ R

T

Figure 8.8 Soil texture map with HWSD viewer
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3. Find the kind of landuses in your catchment. Also here you can use aguila.Think

of a classification of the kind of landuses in your catchment. You can find a
legend of the Globcover in the directory of Globcover.

Find values for your catchment for the parameter FirstZoneKsatVer and make
the input table for WFLOW as explained two pages up.(see Table 5 for
explanation about this variable) . Tip: Use the internet to find the
parametervalue

Find values for your catchment for the parameter InfiltCapSoil and make the
input table for WFLOW as explained two pages up (see Table 6 for explanation
about this variable) . Tip Use the internet to find the parametervalue.

Find values for your catchment for the parameter N and make the input table for
WFLOW as explained two pages up (see Table 7 for explanation about this
variable) . Tip Use the internet to find the parametervalue
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9 Water Balance

Now that the WFlow is working it is time to have a look at the output that is generated.
A first interpretation of the output is to set up a water balance. A water balance is a
calculation of the amount of water in our catchment by balancing the inflows
(precipitation) with all the outflows (discharge, evapo-transpiration, interception, deep

percolation, storage).

To perform the water balance analysis we need to use the WFlow results produced
from the running of the model as shown in Figure Figure 9.1 below.

Running of WFLOW
WELOW results

(DEII sborage

Y
-<d:he's>—|35
I(salebc]

/(n.llcﬁsena}// (actual E\fapdranq:lahm // SEHE)

Analygis of res

A h 4

(Hydrograph, comparison with P,
statistics, seasonal flow)

! K
Excel Analysis Validation Sensitivity Analysis

(compare with standard values
‘or measured data)

{impact of variation
of input)

Figure 9.1 The focus of the water balance analysis

This chapter will deal with a first analysis of
the WFLOW results.

You will first retrieve the data from the model
(the blue boxes in Figure above) and then
you will analyze them with Excel (the green
box of the Figure above). This chapter will
start with a short explanation of the theory
behind the water balance, and will then show
you the correspondence between the water
balance elements and their representation in
WFLOW. After the theoretical part, it will be
discussed how to retrieve the water balance
data from the model and how to make the
calculations.

Transxiratiw

' Precipita

I intmeption

.

Evapotranspiration

-
=]

Infiltration

- -..-...*3

Figure 9.2 lllustration of the water cycle[1]
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9.1 Theoretical background on the water balance
The general equation of the water mass balance for a river catchment is the following:

Inflow — Outflow = AStorage

The picture below shows this general concept of the mass balance equation. A bucket
is filled with water at timestep=t with 30 m® of water. This means the storage at
timestep=t in the bucket is 30 m> At the following timestep: t=t+1, the storage of water is
increased to 40m?®. This is because the inflow has increased with 10m3, while the
outflow remains the same, Therefore 10m? of water is stored extra in the bucket.

Inflow; = 80 Inflow;.1 = 90
l ¢ AS =10
St=30 St+1 =40
Outflow; F 50 Outflow.1 F 50

Figure 9.3 Example of the Mass balance

Taking into account the main elements of the water balance for the catchment, the
above equation can be represented as:

Precipitation - Evapo-transpiration — river discharge -Deep Percolation =
AStorage
The equation can also be written in term of discharge:

Discharge = Precipitation — Evapotranspiration — Deep percolation - AStorage

In WFlow, interception by canopy cover is not directly part of the evapo-transpiration
map. Therefore you have to account for the cumulative effect of interception and
evapotranspiration to represent the whole of the evapo-transpiration component.

At the catchment scale, precipitation represents the main inflow of water in the water
balance equation. Other input sources may be groundwater lateral flow from
neighbouring catchments, or for example, snow melt from glaciers. The outflow
component in the water balance is represented by a number of components.
Evaporation of water from soil surface and transpiration by plants is the first component.
These two factors together are referred to as evapo-transpiration. The other outflow
elements of the water balance are the river discharge, the soil water storage and the
deep percolation to the groundwater table (contributing to groundwater recharge).

An illustration of the water cycle and the water balance elements is provided in Figure
Figure 9.2 and Figure 9.5.
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In our catchment the sum of the inflow minus the sum of the outflow is not zero because
the water that infiltrates the soil also contributes to storage, mainly a storage in the
groundwater but also to surface storage such for example lakes or reservoirs. This
storage components are not directly outputs of WFlow.
Considering the elements of the water balance all together, the water balance equation
can be re-written as follows:

AS =P — Et— Q- SSf-DP + seepage

Where:

S: Storage

P: Precipitation

ET: Evapo-Transpiration
Q: river discharge

SSf: sub-surface flow
DP: deep percolation

Error! Reference source not found. represents a scheme of the water flows in a
catchment.

When precipitation falls, part of it is intercepted by the vegetation canopy cover and
evaporates before it reaches the ground. When the precipitation reaches the ground,
part of it infiltrates into the soil, contributing to soil water storage (which eventually
contributes to either groundwater
recharge, deep percolation or sub- Precipitation=prec
surface flow) while part of it flows on

the soil surface (surface runoff or

overland flow) directly contributing to

river discharge.

Of the water contained in the soil, part

of it will remain in the soil (soil water

t o ﬁ.ﬁctuaEvapoTranspratonaet
content), some will move under
hydraulic gradient to eventually
contribute to river discharge (sub-
surface flow), while the remaining part
will  percolate to the deeper ;.
. Runoff=run
groundwater table or to groundwater river
areas outside of the surface

catchment boundary.

Yet, an evaporation process from soil
open water takes place. This is the
evaporation from the river and, if
present, from lakes or reservoirs.
When vegetation is present in the
catchment, transpiration from plants
takes place.

Storage=stor

Catchment

Figure 9.4 Schematisation of the water flows in a
catchment.
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9.2 Water balance in WFLOW

The water balance described in the theoretical section is also represented in WFLOW.
However, not all the parameters of the water balance are easily retrievable in the
model. Since we will use only the main water balance elements of the equation (Q,
P.ET, interception), the computation of the water balance for the following exercise will
not perfectly sum up to 100% (the water storage map has not been generated and
therefore we do not account for this variable).

The parameters that we will retrieve from WFLOW are shown in Figure 4. Water
storage in lakes is not taken into account during this simulation, although WFLOW can
also compute it. The subsurface flow is calculated but it is hard to retrieve at the
catchment scale.

During the model generation of the water balance output components, WFlow will
perform a rounding of the generated values.

9.3 Retrieving of the parameters
The four parameters to calculate the water balance

(Precipitation, Interception, Actual EvapoTranspiration and },;E{E‘_‘Eiﬁ;mat

Runoff) can all be retrieved from WFLOW as a .tss text file. #CapFlux=cap

These are files containing a table with values for each ﬁPDEUEFPEE Denthefi
tlmgstep and.gaugmg point. ﬂ::lF:UéEEre;:;t:Eugt ir
While runoff is a standard output of WFLOW, for the other #splf.zi=zi

output parameters WFLOW has to be told to produce the HExFiltWater=exf

maps as an output. This is defined in the ini-file #Transfer=tra
(wflow_sbm.ini). In the [outputtss] section, you need to gﬁ::g:ﬁ;;“"nﬁmlt:ﬂf
insert the following commands: #self.Snow=sno
Interception=int #self .Snowkelt=snm

Precipitation=prec
Ce”Storage=St0r ASELt .F1FSTLONEr LUE=TZT

ActEvap=aet #InfiltExcess=infex

The required input typing is shown in Figure 5. #beltaStorage=Del

In the [outputtss] section, while typing the names of the CellInFlow=cif
#self .CumlutFlow=cof

maps we want WFlow to generate, you have to pay _

attention to use the correct typing format: for the Interception=int

description preceding the “=" sign you have to pay Precipitation=prec

attention to the use of capital letters as shown in Figure 5, £06 41 Changing the ini file to get the right

for the part after the “=" sign you can choose yourself the output.

nomenclature. It is however recommended to use the

names as shown in Figure 5.

At this point, after the modification of the ini file, you need to re-run WFlow. Upon

completion of the run, in the output directory you will find the following results: run.tss,

int.tss, prec.tss, stor.tss and aet.tss can be found.

Figure 40 Parameters of WFLOW for the water balance.

9.4 Analyzing the values

The values in the .tss files have to be copied in Excel to be analyzed. Just open the .tss
files (with Notepad, MED or F3 in Total Commander) and copy their content to Excel. In
Excel you can use the Text fo column function (sub-menu of Data) to get the data
organized in column. Select the values you need and copy them to another sheet. This
procedure should be performed for all the parameters.

The unit of measure for the runoff is m*/s while for the other variables is mm. We can
calculate the water balance in terms of volume (Mm3) or depth (m) over a year. This
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means that every element of the water balance equation needs to be computed in
either m® or m. During this exercise we will work in terms of volume. All the input
values are provided per timestep, therefore they are daily values.

To transform the discharge value from cubic meters per second to cubic meters, we
need to know the area of our catchment.

9.4.1 Computing the area of the catchment

The single sub-catchments in your river catchment are shown on the map
wiflow_subcatch.map, contained in the staticmaps directory. Open this map with QGIS
and translate it into ASC format. Then open the ASC with a text-editor and copy the
content to Excel (use again text to column function). Now use the formula COUNTIF to
count the number of cells with the value of your sub-catchment, the right syntax is
=COUNTIF(‘range’,’number’) of which you can see an example below.

This operation will allow you to compute the areas of the single sub-catchments, by
simply using the number of the sub-catchment for which you want to know the area.

¢ Quantum GIS 1.5.0-Tethys EJ@@

File Edit Wi Laver Setting= Plugins Help n

Layars ==

== nyc_4yr colleges
[ ]

=

Bl i3 ﬁ' nyc_facilities

i e ]

= [ ﬁ nyc_Jgreenspace
i :

‘ nyc counties 2008

Crwerriew G@
ls f:oordinate || -73.8370,40.8352 |[icale|[ 1126108 |[ €3] render |[E]

Figure 9.5 Overview of QGIS user interface

Now you have to multiply the amount of counted cells in your sub-catchment by their
unit cell size (in our case: 270*270 and 1080*1080). This will give you the area in
square meters. With this value the water balance inputs can be recalculated to cubic
meters.

9.4.2 Calculating terms of the water balance

At this point, for every time step in our observation year we can calculate how much
different elements contribute to the water balance. You can perform the computation
either in terms of depth (m/month) or in terms of volume (m3/month). Compute — on a
monthly base - the precipitation (m/month), evapo-transpiration (m/month), interception
(m/month) and discharge (m/month) values. Compare the input (precipitation) with the
output and discuss with your group what the main elements of the water balance are,
and what their variability is based on the time of the year. Also observe how the evapo-
transpiration varies to variations in precipitation, and if a correlation factor can be
identified between these variables.
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Figure 9.6 Averagelnterception, actual evapotranspiration and discharge example for the Kumbe River,
Papua

Figure 9.6 provides an example of the contribution of the most important elements of
the waterbalance on monthly basis for the Kumbe River in Papua. From the bar chart
you can see where the water input received via precipitation actually goes. About 45%
of the input is transformed in discharge, about 40% is lost through Evapo-Transpiration,
and about 12% through canopy cover interception. The remaining percentages required
to close the water balance equation is represented by the deep percolation and the soll
water storage.

9.4.3 Exercise 1
Retrieve the precipitation, actual

evapotranspiration, interception, runoff D\Bouke Picter\E
and storage data from WFLOW and copy .
the values into Excel. During your :[@m1
comparison, only make use of the values W2

of the upper sub-catchment we have
defined earlier.

9.4.4 Exercise 2

Find the area of the upper sub-catchment
with Excel. You have to retrieve the
information by using the
wflow_subcatch.map and Aguila. At this
point you can calculate the parameters for
each timestep in m3.

4 [ r
Figure 9.7 Catchment of Citarum in aguila
9.4.5 Exercise 3
Exercise on the analysis of the different water balance elements by taking into

consideration the month to month variation, and the relation existing between the
different elements of the water balance at the same time step.
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10 Precipitation and discharge analysis
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Figure 10.1 Representation of the rainfall to runoff transformation

Source: [Musy, 2011]

This section contains a short theoretical background and the practical exercises to carry
out a precipitation and river discharge analysis, along with its validation and sensitivity

analysis.

The structure of this chapter is the following:

Precipitation analysis

a. Monthly, annual, dry and wet season average precipitation
Discharge analysis

a. General aspects

b. Monthly, annual, dry and wet season average discharge
Temporal comparison of hyetograph and hydrograph
Comparison between modelled and measured discharge data
No non-sense validation

a. Runoff coefficient

b. Computation of expected discharge

For each section, one or more exercises will be provided.

The yellow boxes that you will encounter during the execution of the exercises contain
questions that help you developing a critical thinking about the data you are observing.
Please discuss them with your group members and bring your considerations and

findings up during the group presentations.

105



Use of Global Datasets for Hydro-
Meteorological Analysis in Areas with 1201430 May 2012

Sparse Data

Preliminary

Deltares

The idea of presenting the discharge analysis approach is that you can later apply it to
your WFlow results. However, given that we have run WFlow only for one year, we
cannot perform a statistical analysis by making use of only one year modelled data. For
the only scope of showing how the analysis should be performed, we will now make use
of other sources of data for which we have enough data (measured and modelled)
available.

10.1  Precipitation analysis

A precipitation analysis is needed to identify variation in seasonal rainfall patterns, and
to identify periods of high and low input during the year. Knowledge about precipitation
patterns defines - among other - seeding time of crops, while influencing crop growing
stages. As an example, Figure 10.2 provides an illustration of the influence played by
rainfall on agricultural water demand.
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Figure 10.2 Comparison of precipitation and Irrigation Water Requirements in the Rhine basin

Among other uses, precipitation analysis is also performed to forecast drought periods,
or to determine rainfall intensity values to be used in flood simulation and flood
forecasting.

10.1.1 Exercise: Determine monthly, annual, dry and wet season average precipitation
in your catchment

For this exercise, groups working on the Bian catchment will make use of daily TRMM
calibrated model data, while groups working with the Citarum catchment will work on
daily precipitation data retrieved from the SOBEK model (measured data). The choice
of using external data is driven by the need to use a time period of analysis which is
larger than 1 year (our WFlow simulation time period).

TRMM data for the Bian have been sourced from the precipitation maps of WFlow.
SOBEK precipitation data have been sourced from a previous Deltares project run for
the CitarumRiver basin.

The details about the input for the analysis are the following:
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Tabel 10-1 Information data for the exercise

Bian Citarum
Source of precipitation input | Corrected TRMM SOBEK (measured data)
Available time series 01.03.2002- 01.12.2011 | 02.01.1950 — 30.04.2008
Total time period 9 years 8 months 59 year 3 months
Period to be analyzed 01.03.2002- 01.12.2011 | 02.01.1950 — 01.01.2004
Procedure:
1. Open the P and Q series Excel file and access the precipitation sheet for your
catchment;

2. Make a copy of the original input data sheet to a new sheet and start working on
the latter (DO NOT start working on the original sheet, cause you might
involuntarily modify the input);

3. For the given time period to be analyzed, compute in Excel the following output:

a. Average annual precipitation value (mm/year);

b. Average monthly precipitation values (mm/month);

c. Draw a column chart of the average annual precipitation trend over the time
period of analysis;

An example of the graph you have to produce is provided in Figure 10.3.
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Figure 10.3 Annual precipitation total in the Citarum basin 1950-2008

d. Draw a column chart of the average monthly precipitation trend over the time
period of analysis;

An example of the graph you have to produce is provided in Figure 10.4.
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Average annual distribution of rainfall - Citarum 1950-2008
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Figure 10.4 Annual distribution of rainfall by month in the Citarum river basin

4. Discuss with your team members the results of your first charts

Please address the following questions:

a. What can you tell about monthly and annual variability of rainfall?
b. Can you observe any temporal trend in the precipitation patterns?
c. What can you tell about the seasonal distribution of rainfall?

Definition of dry and wet season

When observing the precipitation patterns for a given basin, region or country, it is often
useful to identify when the wet and the dry season occur within a year. Precipitation is
an atmospheric event that varies over time, and definition of seasonal precipitation is
never a fixed definition. However, observations of long time series values can help
identify indicative seasonal patterns of wet and dry season periods.

To compute the wet and dry season period and average precipitation you can use

different methods. Among the simplest ones you can:

- Observe the annual distribution of rainfall (i.e. Figure 2) and identify a monthly
precipitation threshold separating dry and wet season;

- Use statistical tools to identify precipitation percentage values and their occurrence

We will use this last method to identify the dry and wet seasons for our catchments.
The occurrence of a certain (hourly, daily, monthly or annual)precipitation value over an
observation time period can be computed with percentiles.

The computation of a 40" monthly precipitation percentile over a given time period (i.e.
20 years), provides the value of rainfall (mm/month) that occurs in 60% of the
observations. The use of pre-defined percentile values variables, and depends on the
type of study being processed, the geographic location of the study area and the
variability of the rainfall patterns.

As an example, we will apply NOAA (National Oceanic and Atmospheric Administration

Agency) indications to define a dry and wet month, by respectively applying a 25" and
75" percentile to the rainfall observation datasets we are working with.
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5. Compute the 25™ and 75™ monthly percentiles for the rainfall dataset of your
catchment. And based on that define the average dry and wet season periods

To perform this exercise you have to make use of the percentile function in Excel, and
compute it over the average monthly value of your observation period.

Precipitation thresholds {mmfmonth) manthly average
dry 213 162 186 203 101 30 20 14 26 Ga 199 208 120
wet 326 275 333 269 200 Q8 a1 al 106 210 206 334 218

dry thrsh 120 120 120 120 120 120 120 120 120 120 120 120

wet thrsh 218 218 218 218 218 218 218 218 218 218 218 218

Average annual distribution of rainfall - Citarum 1950-2008
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Figure 10.5 Average monthly rainfall distribution with the average precipitation of the dry and wet season

With this exercise you have now concluded the rainfall analysis, and you have identified
the wet and dry season periods in your catchment.

Please bear in mind that, the larger your observation dataset, the higher the reliability of
your computation in statistical terms, and vice versa.

10.2 Discharge analysis

A discharge analysis provides an overview of the patterns of river discharge over a
given period of time for a given location. River discharge analysis is performed for both
measured and modelled data.

For this workshop a river discharge analysis is needed to verify the quality of data
generated with our hydrological model WFlow. What we want to verify is if the input
provided to WFlow, and the distributed model functioning incorporated in the model do
provide a reliable representation of actual river discharges.

When simulating hydrodynamics in a catchment, and when field measurements are
available, river discharge analysis is performed by comparing modelled with measured
data. However, one should bear in mind that the validity of the comparison is directly
proportional to the quality of the measurements. If for example measured discharge
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series have a long record of missing data, or if the measurements are not recorded
during periods of high flow, the bias in the comparison of measured to modelled data
can be substantial.
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Figure 10.6Example of monthly river discharge curve for a hypothetical river

Yet, another often omitted point of relevance is the comparison of modelled data which
represent the natural flow in the river with measured data which also account for water
withdrawals when surface water is used for productive or consumptive use.

From the above, it follows that the quality of field data needs always to be evaluated,
and in case improved, before comparison with modelled data.
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Figure 10.7 Example of comparison of modeled data for different grid cell resolutions

In hydrological analysis, the first term of comparison is the river hydrograph, which
represents the river discharge at a fix location, projected over a defined time period
(usually a year or a multiple of it). As in the example of the precipitation analysis,
average annual discharge series computed over long time periods (i.e. 50 years)
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provide a more statistically significant term of comparison when estimating annual or
seasonal average discharges, or when computing return periods of peak and low flows.

With reference to the above, the discharge analysis that we will perform during this
workshop is meant only to be representative of the possible methods available for
modelled data validation. Since we have run WFlow only for the year 2008, we will
provide with additional input data for the discharge analysis for your assigned
catchments. Please remember that while the illustrated methodology is a possible
approach to analyze discharge data, the time series needs to be large enough (i.e. > 20
years) to make the statistical findings of the analysis significant.

The data we will use for the analysis are the following:

Table 10-2 Data for this exercise

Bian Citarum Citarum
Source of | WFlow simulation SOBEK simulation PLN measurements
precipitation (measurements)
input
Available time | 01.03.2002- 01.01.1999 —101.01.1919 -
series 01.12.2011 31.12.2007 31.12.2008
Total time | 9 years 8 months 8 years
period
Period to be | 01.03.2002- 01.01.1999 — | 02/01/1950 -
analyzed 01.12.2011 31.12.2007 30.04.2008
Resolution (m) 270 -

Please make sure you are doing your computations on the time period indicated in the
table.

10.2.1 Exercise: Determine monthly, annual, dry and wet season average discharge in
your catchment

The procedure to be followed to perform a preliminary hydrological analysis or river
discharge follows the same procedure as the one described in the precipitation
analysis. At this stage however, you already know the duration of the dry and wet
season in your catchment, and you can try to produce seasonal statistics of discharge
specific to these two time periods.

Procedure:
1. Open the P and Q series Excel file, and access the discharge sheet of your
catchment;

For the groups working on the Bian catchment, the analysis should be performed for all
the 4 gauging stations listed in the Excel sheet.

For the groups working on the Citarum catchment, group 6 should work on the
Citarum_obs sheet while group 4 and 5 should work on both discharge series in the
Citarum_mod&obs sheet. Results from these analyses will then be compared during the
group presentations.
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2. Make a copy of the original input data sheet to a new sheet and start working on the
latter;

3. For the given time period to be analyzed, compute in Excel the following output:

a. Average annual discharge value (m3/s) and average annual total discharge
(Mm3/year);

b. Average monthly discharge values (m3/s);

c. Draw the hydrograph of your river catchment:

-> by plotting average monthly values for your period of analysis;
- by plotting — for a selected year — the daily values over the year;

An example of yearly hydrograph drawn using daily values is provided in Figure 6
below.
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Figure 10.8 Hydrograph for the Bian River in 2008

d. Select a random year in your dataset, and plot the hydrograph for the
selected year against the average hydrograph for the observation time period

An example of the outcome of this exercise is provided in Figure 10.9. Discuss with

your group what the most striking points you can detect from the comparison are. You
can later present and discuss them during the group presentations.
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Figure 10.9 Hydrograph comparison between 2004 and average values, Bian River

4. Discuss with your team members the results of your analysis

Please address the following questions:

e. What can you tell about monthly and annual variability of discharge?

f. Can you observe any temporal trend in the discharge patterns?

g. What can you tell about the seasonal distribution of discharge over an
average year?

The last step of the analysis now requires you to have a closer look at the discharge
patterns in your river catchment considering the dry and wet season which you have
identified in Section 1 (precipitation section).

(The following 3 exercises should be performed only if there is sufficient time available)

5. Compute the average and minimum discharge values for the dry season period
(m3/s);

6. Compute the average and maximum discharge values for the wet season period
(m3/s);

You can perform step 5 and 6 the same way we have used to define the dry and wet
season during the precipitation analysis. You can discuss in your group which
percentiles you want to choose to identify minimum and maximum discharges.

7. Compare the average dry and wet season discharge values with the yearly average
values

Observe the difference in the discharge ranges between the 3 projected hydrographs
and discuss it with the members of your group.
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What can you tell about the use of yearly average discharge values when you need to
retrieve information on dry months?

Are the annual average data good enough to represent the discharge series during the
dry season?

Temporal comparison of hyetograph and hydrograph

A comparison of the rainfall and discharge patterns helps providing an idea of the
rainfall to runoff transformation that occurs in our catchments. It also gives a mean to
better understand the hydrological patterns in the basin, and create expectations on the
outcome of the modelled results of our analysis.

We will now project the hyetograph against the hydrograph to make considerations
about the findings.

10.2.2 Exercise: For a selected year, plot the hyetograph of your catchment against its
corresponding hydrograph

- first plot daily values, and then plot monthly values

-> precipitation should be plotted on the second y axis and should be in a
form of a bar chart;

- discharge is plotted on the primary y axis in the form of a line;

- select a given year and observe the trend of the bar chart and the line

To perform this exercise you have to select the same time period of observation, and
make sure that the precipitation series you are using have a spatial correspondence
with the area of the basin for which we are measuring discharge.

Bian catchment

The groups working on the Bian catchment can make use of the corrected TRMM data
and the modelled discharge data for the 4 gauging points along the river, for the entire
simulation time period (02.03.2002 to 01.12.2011). They can then pick up a specific
year (i.e. 2008) and a specific time period within the year (i.e. dry season) to
simultaneously analyze the patterns of precipitation and discharge.

To have an overview of the rainfall to runoff transformation in the catchment, the most
important comparison is the one projecting the hyetograph with the most downstream
gauging point. This is because the latter represents the cumulative discharge of the
river from its most upstream points.

Figure 10.10 below provides an example of how the graph should look like.
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Figure 10.10Hyetograph and hydrograph at comparison for the Bian catchment, 2008

Citarum catchment

The comparison for the Citarum catchment can be done for the year 2008 from the
precipitation and discharge data obtained from the TSS WFlow files. Alternatively the
comparison can be done for a selected year from the data previously elaborated (Sobek
modelled precipitation and discharges).

Another method to have an overview of the relationship existing between the discharge
of a river and the precipitation that influences it, is to plot the discharge against the
precipitation to see if there is a linear correspondence between an increase in
precipitation and an increase in discharge.

The slope of the trend line of the scatter plot tells you what the rate of discharge
increase (or decrease) for a unit increase (or decrease) in precipitation is.

10.2.3 Exercise: For a selected 8-year time period, provide the scatter plot of the
rainfall to runoff relation and make considerations about your findings

A long time series scatter plot of rainfall to discharge helps you analyze the
correspondence between a certain rainfall range and the discharge value
corresponding to it. The slope of the linear trend in the rainfall-runoff plot gives you a
measure of the rate of change in discharge, given a certain rainfall input.

It is recommended to perform this exercise for a large enough time period to provide
statistical significance to the comparison. During this workshop, the minimum time step
for which we can perform this exercise is one year. You can use this exercise as a pure
example of how you can perform this test on a larger time step.

Alternatively, you can make use of the measured and modelled data from the provided
datasets to test the rainfall to runoff correspondence for a larger period of time (i.e. 20
years).
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First perform the test using the precipitation and runoff data generated with WFlow. This
will provide a first good test to spot any inconsistency in the output of the model, if any.

Figure 10.11 provides an illustration of how the scatter plot for the rainfall to runoff
relation should look like.
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Figure 10.11 Example of rainfall - runoff relation

One should expect a linear trend in the rainfall to runoff relation, meaning that the
higher the rainfall range, the higher the expected discharge.

10.3 Validation of discharge series

Once you have performed this preliminary analysis of your modelled data, you can
proceed with the validation process. The validation of the modelled discharge series
can be carried out in two ways, depending on weather measurements of river discharge
from the field are or are not available. When observed discharge series are not
available, a no non-sense validation can be carried out.

10.3.1 Comparison with measured data

During this workshop, we will carry out the comparison with measured data using the
available data from the Citarum catchment. There is no measured data available for the
Bian catchment. Therefore the groups working on the Bian catchment will have to use
the observed measurements for the Citarum to carry out this analysis.

The scope of this exercise is to compare measured with modelled discharge series,
therefore we will not use the output generated with QGIS, since we have results only for
one year.

The reference time period that we will use for this exercise is 01.01.1999 — 31.12.2007.
You find the data in the Q_Citarm_mod&obs sheet of the P and Q series Excel file.
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Measured data come from PLN (Perusahaan Listrik Negara), while modelled data have
been generated with the Sobek (Deltares) model.

Exercise: For the given time period, draw the hydrograph of the modelled and
observed data using monthly average values for the observation period

You should execute this exercise by first computing the monthly average values from
the daily values for both observed and modelled data, and then select a year for the
comparison.

The example provided in Figure 10.12 you can have an overview of how the output of
the exercise should look like. Based on the shape of the hydrograph you can also make
your considerations about the ability of the model to represent the real discharge
situation in the catchment.

Modelled vs observed discharge, Citarum 2002

200
180 — model H
1?3 \\\ /f—“—w"'n nhzered
120 SN k) /
100 S k)

" | 77
60 ) ;
a0 ) 77
50 L i

Precipitaiton {mm/moanth)

Month

Figure 10.12 Comparison of the Citarum hydrograph for observed and modeled data

You can repeat this exercise for other years in the range, or opt to analyze them over
the entire observation time period. This way you can verify if you verify if your
interpretation of the difference between modelled and observed data equally applies to
a different simulation year.

When you are testing your model results against the hydrograph generated with the
measured data, it is interesting to observe what the advantage of using different
resolutions (i.e. coarse versus fine) is. When comparing it with the hydrograph
generated from measured data, if the hydrograph of modelled discharge with a coarse
resolution is equivalent to that of a model run with a finer grid, then you might conclude
that it is worth using the coarse resolution for your modelling. This will help you save
computation time, without forgoing the good fitting of model results with observed
measurements.
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10.3.2 No non-sense validation

The no non-sense validation represents the analytical process you have to undergo to
analyze modelled discharge series when measured data are not available for
comparison.

We will compute the no non-sense validation for both the Citarum and the Bian
catchments discharge series generated with WFlow for the test year 2008.

The ratio between the discharge of a river and the contributing rainfall falling in the
catchment area where the discharge is generated is called runoff coefficient. The runoff
coefficient gives an indication of what is the percentage of rainfall that directly
transforms into runoff.

. Discharge
Re(runoff _ coefficient) = ———— g'
Precipitation

The value of the runoff coefficient is determined by a number of different variables,
among which the infiltration capacity of the soil and the slope are the most important
factors. In turn, the infiltration capacity of soils is determined by the type of land cover
and the type of soils present in the catchment. An example of how the runoff coefficient
varies according to soil type and slope is provided in Table 10-3 Runoff coefficient
values for cultivated area below:

Table 10-3 Runoff coefficient values for cultivated area

Land cover type Soil type Flat slope | Steep slope

Cultivated land Clay, loam 0.50 0.60

Cultivated land | Sand, Gravel 0.25 0.35

Source: Department of Transportation, Oregon State, US™

In the 1990s, Rob van der Weert carried out an extensive study to analyze and
characterize hydrological conditions for Indoensia. The report is called Hydrological
conditions in Indonesia and it provided with the content of this workshop. In this report
you can fin reference to the values of the runoff coefficient for Indonesia, based on
different annual rainfall ranges, which are location specific.

Figure 10.12 Comparison of the Citarum hydrograph for observed and modeled data is
taken from [van der Weert, 1994] and illustrates the results of his study for the rainfall to
runoff relation for the whole of Indonesia. The runoff coefficient can be computed from

"“You can find a completed list of runoff coefficient for different surface types at:
ftp://ftp.odot.state.or.us/techserv/Geo-Environmental/Hydraulics/Hydraulics
Manual/Chapter_07/Chapter_07_appendix_F/CHAPTER_07_appendix_F.pdf
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the curve by dividing the value of runoff by the corresponding value of rainfall specific to
the catchment you are analyzing.
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Figure 10.13 Rainfall to runoff relation for Indonesia

Source: R. v. d. Weert, 1994

10.3.3 Exercise: Compute the runoff coefficient (RC) for your catchment:
- Yearly runoff coefficient
- Wet season runoff coefficient
- Dry season runoff coefficient

In order to compare the discharge with the rainfall, we need to work with the same unit
of analysis (i.e. water depth, volume). We will compute the runoff coefficient by using as
a unit of measure the depth of rainfall and of the discharge. To compute the discharge
in terms of depth, we need to know the area of our catchment.

The procedure to compute the runoff coefficient for your modeled data is the following:

a. Compute the total area from the vector map (in m2) [this value has already been
computed during the water balance analysis];

b. get the average (yearly and seasonal) modelled value of Q (m3/s) for your
catchment for the selected analysis period (i.e. wet season);

c. transform the average Q from m3/s to m3/year or to m3/season;

d. computed the runoff (in meters) as the ratio of discharge to total catchment area
(Q/A);

e. compute the depth of the precipitation (m/year or m/season);
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f. compute the runoff coefficient by dividing the runoff value (m) by the P value (m);

g. compare the value of the RC you have just computed with the reference value
provided by [van der Weert, 1994] and draw your conclusions from this
comparison.

The computation of the RC can also be performed for the measured data. This would
give you a good indication about the quality of the measurements (assuming that the
reference values you are using are representative for your catchment).

Observing the value of the runoff coefficient for the different seasons and comparing
them with the precipitation total over the observation period, answer the following
questions?

1. How can you interpret the variation of the runoff coefficient from the wet to the
dry season?

2. What is the meaning of a runoff coefficient close to 1?

3. Which saturated soil conditions (high or low saturation) would you expect to be
equivalent to a runoff coefficient of 0.2?

4. What rainfall intensity (high or low) would you expect to be equivalent to a runoff
coefficient of 0.9?

5. What correspondence do you think there is between the runoff coefficient and
topography?

You can now include the answers to these questions in the group presentation for the
morning session.

11 Sensitivity analysis

A sensitivity analysis is run to test what is the influence played by model parameters on
river discharge. The aim of this analysis is therefore to test how sensible the river flow is
to variations in variables such as, for example, the infiltration capacity or the evapo-
transpiration.

During this workshop, we are going to test the catchment response to positive and
negative variations of the variables contained in Table 11-1. Please remember that intbl
parameters are defined within a [min,max] range, and that, where the parameter value
has already been defined at its upper or lower boundary condition, this value can not go
beyond its minimum or maximum values.

In order to be able to compare the influence played by the different parameters on the
discharge series, we will use the same percentage change for all of them.

Table 11-1 Model parameters for sensitivity analysis

Parameter Intbl name Varied
value
Free through-fall coefficient CanopyGapFraction | - 50%
First zone saturated hydraulic conductivity FirstZone KsatVer + 50%
Infiltration capacity of unpaved soil layer InfiltCapSoil -50%
Water content at saturation ThetaS + 50%
Manning parameter for the kinematic wave | N +50%
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11.1  Exercise: Perform the sensitivity analysis on the river discharge by
testing 3 variables from Table 2
Procedure:
1. If you have not saved the results of the model run with the default parameter
values, please do so now;
2. Select 3 parameters of the 5 listed in Table 2 for which you want to run the
sensitivity analysis;
3. Copy the default parameter values before changing them (you will need to change
them back later on!)
4. Compute the suggested percentage change variation for the first parameter that
you have selected, change the values in the intbl and run the model;
5. save the results and compare the generated hydrograph with the one generated

with the default values;

After computing the above mentioned steps, answer the following questions:

a. Which changes do you notice?
b. How is the hydrograph shape changing?
c. What is the percentage change in the average river discharge corresponding to
the percentage change of your selected parameter?
d. Why do you think this is happening?
6. now you can try to change the values of the second parameter you have selected.

To be able to observe what the influence is, change back to their default, the
values of the parameter that you have changed at the previous step;
perform step 6 also for the 3 parameter

What are your conclusions about the sensitivity analysis?
Which of the above factors do you find more important in changing the shape of our
river hydrograph?
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Soil maps

= General: http://www.fao.org/geonetwork/srv/en/main.home

= ASRIS http://www.asris.csiro.au/index other.html

= [SRIC http://www.isric.org/

= Soil moisture storage capacity: http://www.fao.org/nr/land/soils/en/

http://www.fao.org/geonetwork/srv/en/main.home
Soil depth: http://www.fao.org/nr/land/soils/en/
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